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About This Document
This manual is intended for administrators and users of 
Axis video servers. The models covered by this manual are 
AXIS 241S, AXIS 241SA, AXIS 241Q, AXIS 241QA, and 
AXIS 242S IV, with firmware release 4.30. The manual 
includes instructions for using and managing the Video 
Server on your network. Previous experience of networking 
will be of use when installing and using this product. Some 
knowledge of UNIX or Linux-based systems would also be 
beneficial, for developing shell scripts and applications. 
Later versions of this document will be posted to the Axis 
Website, as required. See also the product’s online help, 
available via the Web-based interface.

Safety Notices Used In This Manual
Caution! - Indicates a potential hazard that can damage the 
product.
Important! - Indicates a hazard that can seriously impair 
operation. 
Do not proceed beyond any of the above notices until you 
have fully understood the implications.

Intellectual Property Rights
Axis AB has intellectual property rights relating to 
technology embodied in the product described in this 
document. In particular, and without limitation, these 
intellectual property rights may include one or more of the 
patents listed at http://www.axis.com/patent.htm and one 
or more additional patents or pending patent applications 
in the US and other countries.
This product contains licensed third-party software. See the 
menu item “About” in the product’s user interface for more 
information.

Legal Considerations
Camera and audio surveillance can be prohibited by laws 
that vary from country to country. Check the laws in your 
local region before using this product for surveillance 
purposes. This product includes one (1) MPEG-4 decoder 
license. To purchase further licenses, contact your reseller.

Electromagnetic Compatibility (EMC)
This equipment generates, uses and can radiate radio 
frequency energy and, if not installed and used in 
accordance with the instructions, may cause harmful 
interference to radio communications. However, there is no 
guarantee that interference will not occur in a particular 
installation. If this equipment does cause harmful 
interference to radio or television reception, which can be 
determined by turning the equipment off and on, the user is 
encouraged to try to correct the interference by one or 
more of the following measures: Re-orient or relocate the 
receiving antenna. Increase the separation between the 
equipment and receiver. Connect the equipment to an 
outlet on a different circuit to the receiver. Consult your 
dealer or an experienced radio/TV technician for help. 
Shielded (STP) network cables must be used with this unit 
to ensure compliance with EMC standards.

USA - This equipment has been tested and found to 
comply with the limits for a Class B computing device 
pursuant to Subpart B of Part 15 of FCC rules, which are 
designed to provide reasonable protection against such 
interference when operated in a commercial environment. 
Operation of this equipment in a residential area is likely to 
cause interference, in which case the user at his/her own 
expense will be required to take whatever measures may be 
required to correct the interference. 
Europe  -  This digital equipment fulfills the requirements 
for radiated emission according to limit B of EN55022/1998, 
and the requirements for immunity according to EN55024/1998 
residential, commercial, and light industry.

Liability
Every care has been taken in the preparation of this manual; 
Please inform your local Axis office of any inaccuracies or 
omissions. Axis Communications AB cannot be held responsible 
for any technical or typographical errors and reserves the right 
to make changes to the product and manuals without prior 
notice. Axis Communications AB makes no warranty of any 
kind with regard to the material contained within this 
document, including, but not limited to, the implied warranties 
of merchantability and fitness for a particular purpose. Axis 
Communications AB shall not be liable nor responsible for 
incidental or consequential damages in connection with the 
furnishing, performance or use of this material.

Trademark Acknowledgments
Ethernet, Internet Explorer, Linux, Microsoft, Mozilla, OS/2, 
UNIX, Windows, WWW are registered trademarks of the 
respective holders. QuickTime™ is a trademark of Apple 
Computer, Inc., registered in the U.S. and other countries. Java 
and all Java-based trademarks and logos are trademarks or 
registered trademarks of Sun Microsystems, Inc. in the United 
States and other countries. Axis Communications AB is 
independent of Sun Microsystems Inc. UPnP™ is a certification 
mark of the UPnP™ Implementers Corporation.

Support Services
Should you require any technical assistance, please contact 
your Axis reseller. If your questions cannot be answered 
immediately, your reseller will forward your queries through 
the appropriate channels to ensure a rapid response. If you are 
connected to the Internet, you can:
• download user documentation and firmware updates
• find answers to resolved problems in the FAQ database. 

Search by product, category, or phrases
• report problems to Axis support staff by logging in to your 

private support area
• visit the Axis Support Web at www.axis.com/techsup/

Safety Notice - Battery Replacement
The Video Server uses a 3.0V CR2032 Lithium battery as the 
power supply for its internal real-time clock (RTC). This battery 
will, under normal conditions, last for a minimum of 5 years. 
Low battery power affects the operation of the RTC, causing it 
to reset at every power-up. A log message will appear when 
battery replacement is required.

The battery should not be replaced unless required!
If the battery does need replacing, observe the following points:

Caution!
• Danger of Explosion if battery is incorrectly replaced
• Replace only with the same or equivalent battery, as 
   recommended by the manufacturer.
• Dispose of used batteries according to the manufacturer's 
   instructions.

AXIS Video Servers User’s Manual 
Revision 1.0
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Part No: 26525 
Copyright© Axis Communications AB, 2005-2006
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Product description
This manual covers the following Axis video servers:

• AXIS 241S: 1-port video server (and blade version)
• AXIS 241Q: 4-port video server (and blade version)
• AXIS 241SA: 1-port video server including 2-way audio
• AXIS 241QA: 4-port video server including 2-way audio
• AXIS 242S IV: 1-port video server with support for Intelligent Video (IV) modules

Overview - all models
The Axis video server is fully featured for security surveillance and remote monitoring 
needs. It is based on the AXIS ARTPEC-2 compression chip, and can digitize up to 4 
analog video sources and make these available on the network as real-time, full frame rate 
Motion JPEG and/or MPEG-4 video streams. 

The Axis video server is equipped with RS-232 and RS-485 ports for connecting third 
party PTZ systems. The 4 alarm inputs and 4 alarm outputs can be used to connect various 
third party devices, e.g. door sensors and alarm bells. 

Up to 20 viewers can access the Axis video server simultaneously when using Motion 
JPEG and MPEG-4 unicast. The number of simultaneous viewers can be increased by using 
multicast MPEG-4. When using AXIS Media Control (AMC) to view MPEG-4 video 
streams, each MPEG-4 viewer requires a separate MPEG-4 decoder license. One licence is 
included, and further licenses can be purchased separately from your Axis dealer. If using 
other clients to view the MPEG-4 video stream, no further MPEG-4 decoder licenses are 
required.

Video can be viewed in 5 resolutions (up to 4CIF), and image compression is configurable. 
The Axis video server contains support for video motion detection, which allows the unit 
to trigger on activity in the video image, and advanced scheduling tools which can also be 
used to trigger an event. As the Axis video server is designed for use in security systems, it 
is equipped with several security features, such as IP address filtering, several user levels 
with passwords and HTTPS.

The Axis video server has a built-in web server, providing full access to all features 
through the use of a standard web browser. The built-in scripting tool allows basic 
applications to be created, providing basic surveillance solutions. For advanced 
functionality, the Video Server can be integrated via the use of the AXIS VAPIX API (see 
www.axis.com/developer for further information).
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Overview - AXIS 241Q/QA
The AXIS 241Q and AXIS 241QA each provide 4 BNC inputs for connecting analog video 
devices. 

The AXIS 241QA also provides a Line/Mic In (mono) connector for connecting an external 
microphone or other source producing a line level signal. An active speaker with a built-in 
amplifier can be connected to Line Out (mono), to enable two-way communication. Audio 
communication can be bi-directional (full-duplex), push to talk (half-duplex) or in one 
direction only (simplex). 

DIP switch

LED indicators for Network, Status & Power  

Video input (x4)Control button
Line/Mic In & 

Line Out
(241QA only)

Front panel - AXIS 241Q/QA

Overview - AXIS 241S/SA
The AXIS 241S and AXIS 241SA both provide 1 BNC input and 1 matching loop-through 
output. These models can also accommodate S-Video (Y/C) by using a Y/C to BNC cable 
(not included). See page 60 for more information.

The AXIS 241SA also provides a Line/Mic In (mono) connector for connecting an external 
microphone or other source producing a line level signal. An active speaker with a built-in 
amplifier can be connected to Line Out (mono) to enable two-way communication. Audio 
communication can be bi-directional (full-duplex), push to talk (half-duplex) or in one 
direction only (simplex). 

Video input

Control button

Line/Mic In 
& Line Out

(AXIS 241SA 
only)

Video output

DIP switchFront panel - AXIS 241S/SA

LED indicators for Network, Status & Power  
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Overview - AXIS 242S IV
The AXIS 242S IV provides support for Intelligent Video (IV) modules, and is equipped 
with a DSP (Digital Signal Processor) dedicated to processing advanced intelligent video 
algorithms. 

IV modules (IVMs) are uploaded to the video server, and each module provides its own 
configuration page. See page 34 for more information.

The AXIS 242S IV provides 1 BNC input and 1 matching loop-through output. S-Video 
(Y/C) is accommodated directly via the supplied connector.

The AXIS 242S IV also provides Line In and Mic In connectors. These are used for audio 
analysis purposes only.

Video input
Control buttonMic In & Line In 

Video outputS-Video (Y/C) input

DIP switch
DSP & IV LED indicators

Front panel - AXIS 242S IV

LED indicators for Network, Status & Power  

LED indicators - all models 
After completion of the startup and self-test routines, the multi-colored LED indicators 
signal the following conditions:

Unlit No connection.

Green Steady for connection to a 100 Mbit/s network. Flashes for network activity.

Amber Steady for connection to a 10 Mbit/s network. Flashes for network activity.

Unlit When configured for “no flash” on access.

Green Steady for normal operation. Can be configured to flash green at intervals 
whenever the unit is accessed. See the online help for more information.

Amber Steady during startup, reset to factory default or when restoring settings.

Red Slow flash for failed firmware upgrade.

Green Normal operation.

Amber Flashes green/amber during firmware upgrade.

Unlit No IV module loaded.

Amber Steady for no IV module. Flashes during IV module upload.

Green Steady for IV module loaded.

Module.-specific operation. See the documentaion for the IV module.

Network

Status

Power

DSP  
(AXIS 242S IV only)

IV 
(AXIS 242S IV only)
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Switches & connectors
DIP switch (AXIS 241Q/QA) - A corresponding line termination switch is supplied for each 
video input. All units are shipped with line termination enabled for each video input; that 
is, with the DIP switch set in the down position.

DIP switch (AXIS 241S/SA) - Upon delivery the dip switch on the AXIS 241S/SA is 
configured for composite video input, as follows:

1 2 3 4

on off on n/a

on on off n/a

Notes: •If the video source is to be connected in parallel with other equipment, disable the input termi-
nation by turning the corresponding DIP switch to the up position (OFF). Failure to do so may 
cause reduced image quality.

•The AXIS 241S/SA supports conversion between composite video and Y/C (S-Video) using a Y/C 
to BNC cable (not supplied).

DIP switch (AXIS 242S IV) - The AXIS 242S IV provides a single DIP switch for line 
termination of the video input. Slide the switch to the right to enable.

Control Button - Press this button to restore the factory default settings, as described in  
Resetting to the factory default settings, on page 56, or to install using AXIS Internet 
Dynamic DNS Service (See the Axis Video Server Installation Guide).

Video Input - Each supported video input (1 or 4 depending on the model) is connected 
using a coax/BNC connector. Physical connections made using 75 ohm coaxial video cable 
have a recommended maximum length of 800 feet (250 meters).

Video Output (AXIS 241S/SA) - Loopthrough connection to the video signal from the 
Video In connector. Terminated with a coaxial/BNC connector. Allows direct connection of 
e.g. an external monitor. Set DIP switch to OFF when in use.

Video Output (AXIS 242S IV) - Video is available on this output when the Digital Signal 
Processor (DSP) is running an Intelligent Video module. 

Line Out (AXIS 241SA and AXIS 241QA only) - Mono audio output (line level), which can 
be connected to a public address (PA) system or an active speaker with a built-in amplifier. 
A pair of headphones can also be attached. 

Line/Mic In (AXIS 241QA and AXIS 241SA only) - Single 3.5mm input for a mono 
microphone, or line level mono signal (only the left channel is used from a stereo signal). 

Line In & Mic In (AXIS 242S IV only) - 2 separate inputs for Line In and Mic In, 
respectively. Note that these inputs are used for internal audio analysis only.

Switch

Description
75 ohm video in

termination
75 ohm video out

termination
Connects video in and 

video out
Not used

Composite video input

Y/C video input
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Rear panel - all models

Power adapter

connector
12-pin I/O terminal

connector

RS-232
connector

Network
connector

Serial number on underside label

Power adapter connector - For connection of the power adapter. 

I/O terminal connector - The I/O terminal connector provides the physical interface to 4 
digital transistor outputs, 4 digital inputs and an RS-485 interface. See Unit connectors, on 
page 57 for more information.

Note: The I/O terminal connector also provides an auxiliary connection point for DC 
power.

Network connector - The Axis video server connects to the network via a standard 
network cable, and automatically detects the speed of the local network segment 
(10BaseT/100BaseTX Ethernet).

RS-232 connector - A 9-pin D-SUB connector providing an RS-232 serial connection. 
Typically used for connecting Pan/Tilt/Zoom devices. See Unit connectors, on page 57 for 
more information.
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Using the video server
The Axis video server can be used with most standard operating systems and web 
browsers. The recommended browser is Internet Explorer with Windows, and Mozilla with 
other operating systems. See also the Technical specifications, on page 66.

Note: For information on installing the video server, please refer to the Installation Guide.

Accessing the video server
1. Start your web browser. 

2. Enter the IP address or host 
name of the Axis video 
server in the Location/Address field of your browser.

3. Enter the user name and password set by the administrator. 

4. A video image is displayed in your browser. 
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Notes: •To view streaming video in Microsoft Internet Explorer, you must set your web browser to allow 
the AXIS Media Control (AMC) to be installed on your computer. AMC is required to use audio in 
the AXIS 241SA and AXIS 241QA. AMC also provides an MPEG-4 decoder for viewing MPEG-4 
video streams. This decoder is installed the first time an MPEG-4 video stream is accessed. 
Please note that the product administrator may have disabled the installation of the decoder, as 
a license is required for each instance. See page 32 for more information.

•If your workstation restricts the use of additional software components, the Axis video server 
can be configured to use a Java applet for updating JPEG images. Please see the online help for 
more information.

The Live View page
If your Axis video server has been customized to meet specific requirements, the buttons 
and other items described below may or may not be displayed on the Live View page. The 
following provides an overview of each available button:

To resize the displayed image, click the View Size buttons: half-size 
(x1/2), full-size (x1), x2 or x4. This will not change the resolution of the 
image (not available in Sequence Mode).

 
The Video Format drop-down list allows the video format on the Live 
View page to be temporarily changed. 

Pulse - click this button to activate the port 
for a defined period of time, e.g. to switch on 
a light for 20 seconds. 
 
Active/Inactive - click these buttons to 
manually start and stop a connected device, 
e.g. switch a light on/off.

The Output buttons control 
an output directly from the 
Live View page. These 
buttons are configured 
under Setup > Live View 
Config > Layout.

The IV buttons are used to configure and view the status for the currently 
running IV module (AXIS 242S IV only).

These buttons start/stop the Sequence Mode. This mode is created in Setup > 
Live View Config > Sequence mode and automatically displays the view 
from 2 or more video sources at set intervals.

From the Source list, select the desired video image(s). The list can 
contain internal video sources, external video sources, or the Quad 
Stream view (AXIS 241Q/QA only). The Quad Stream option displays 
all four video images in one stream. 
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AMC Audio controls (AXIS 241SA and AXIS 241QA)
There are audio controls for controlling the client computer’s speaker output. These 
controls are only available in the MPEG-4 video format and when audio is enabled, see  
Audio Settings, on page 25.

Click the Speaker and Microphone buttons to switch the sound off and on, for the 
speaker and microphone, respectively.  
 

Use the slider to control the volume on the speaker and microphone. 
The volume can be set between 0 and 100. 

When using Half-duplex mode, this button toggles between allowing you to speak 
and listen. The first icon indicates that you can talk and the speaker attached to the 
video server plays your voice. The second icon indicates that you will hear audio 
from the video server, but no audio is sent to web clients. When in simplex talk 

mode, the icon toggles between allowing you to speak, and is dimmed when you do not 
want other clients to receive any audio.

Note that these AMC toolbar functions can also be accessed by right-clicking in the image.

For information on using Pan/Tilt/Zoom controls, please see Pan Tilt Zoom, on page 41.

The trigger buttons trigger an event directly from the Live View page. These 
buttons are configured under Setup > Live View Config > Layout. Click these 
buttons to manually start and stop events.

Use the Snapshot button to capture a snapshot of the image currently being 
displayed in the window. Right-click on the image to save it in on your 
computer.

The AMC viewer toolbar (AXIS Media Control) is available in Microsoft Internet 
Explorer only and displays the following buttons:

The Play/Stop buttons start and stop the media stream.

The Snapshot button saves a snapshot of the video image currently being 
displayed. The Snapshot function and the target directory for saving snapshots 
can be configured from the AMC Control Applet, which can be opened from the 
Windows Control Panel or by right-clicking the image in Internet Explorer.
Click the View Full Screen button and the video image will fill the entire screen 
area. No other windows will be visible. Press Esc (Escape) on your keyboard to 
cancel full screen view.
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Video and audio streams
The Axis video server provides several different video and audio stream formats. The type 
to use depends on your requirements and on the properties of your network. 

The Live View page in the Axis video server provides access to Motion JPEG and MPEG-4 
video and audio streams, as well as to single JPEG images. Other applications and clients 
can also access these video and audio streams/images directly, without going via the Live 
View page. 

Video stream types

Motion JPEG
This format uses standard JPEG still images in the video stream. These images are then 
displayed and updated at a rate sufficient to create a stream that shows constantly updated 
motion. 

The Motion JPEG stream provides excellent image quality and access to each and every 
individual image contained in the stream. 

Note also that multiple clients accessing Motion JPEG streams can use different image 
settings.

MPEG-4
This is a video compression standard that makes good use of bandwidth, and which can 
provide high-quality video streams at less than 1 Mbit/s.

The MPEG-4 standard provides scope for a large range of different coding tools for use by 
various applications in different situations, and the Axis video server provides certain 
subsets of these tools. These are represented as Video object types, which are selected for 
use with different viewing clients. The supported video object types are:

• Simple - sets the coding type to H.263 
• Advanced Simple - in Axis products, this sets the coding type to MPEG-4 Part 2

AMC (AXIS Media Control) supports both object types, whilst e.g. QuickTime™ requires the 
Simple object type.

When using MPEG-4 it is also possible to control the bit rate, which in turn allows the 
amount of bandwidth usage to be controlled. CBR (constant bit rate) is used to achieve a 
specific bit rate by varying the quality of the MPEG-4 stream. When using VBR (variable 
bit rate), the quality of the video stream is kept as constant as possible, at the cost of a 
varying bit rate. 
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Notes: •MPEG-4 is licensed technology. The Axis video server includes one license for the decoder 
required for viewing in AMC. Installing additional unlicensed copies of this decoder is prohib-
ited. To purchase more decoder licenses, contact your Axis reseller.

•All clients viewing the MPEG-4 stream must use the same image settings.

MPEG-4 protocols and communication methods
To deliver live streaming video over IP networks, various combinations of transport 
protocols and broadcast methods are employed.

• RTP (Real-Time Transport Protocol) is a protocol that allows programs to manage 
the real-time transmission of multimedia data, via unicast or multicast. 

• RTSP (Real-Time Streaming Protocol) serves as a control protocol, to negotiate 
which transport protocol to use for the stream. RTSP is thus used by a viewing 
client to start a unicast session, see below.

• UDP (User Datagram Protocol) is a communications protocol that offers limited 
service for exchanging data in a network that uses the Internet Protocol (IP). UDP 
is an alternative to the Transmission Control Protocol (TCP). The advantage of 
UDP is that it is not required to deliver all data and may drop network packets 
when there is e.g. network congestion. This is suitable for live video, as there is 
no point in re-transmitting old information that will not be displayed anyway.

• Unicasting is communication between a single sender and a single receiver over a 
network. This means that the video stream goes independently to each user, and 
each user gets their own stream. A benefit of unicasting is that if one stream fails, 
it only affects one user.

• Multicast is bandwidth-conserving technology that reduces bandwidth usage by 
simultaneously delivering a single stream of information to multiple network 
recipients. This technology is used primarily on delimited networks (intranets), as 
each user needs an uninterrupted data flow and should not rely on network  
routers.

AXIS Media Control (AMC)
The recommended method of accessing live video (MPEG-4 and/or Motion JPEG) and 
audio from the Axis video server is to use the AXIS Media Control (AMC) in Microsoft 
Internet Explorer in Windows. This ActiveX component is automatically installed on first 
use, after which it can be configured by opening the AMC Control Panel applet from the 
Windows Control Panel. Alternatively, right-click the video image in Internet Explorer.
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How to stream MPEG-4
Deciding on the combination of protocols and methods to use depends on your viewing 
requirements, and on the properties of your network. Setting the preferred method(s) is 
done in the control applet for AMC, which is found in the Windows Control Panel. When 
this has been set, AMC will test all the selected methods in the specified order, until the 
first functioning one is found.

RTP+RTSP 
This method (actually RTP over UDP and RTSP over TCP) should be your first 
consideration for live video, especially when it is important to always have an up-to-date 
video stream, even if some images do get dropped. This can be configured as multicast or 
unicast. 

Multicasting provides the most efficient usage of bandwidth, especially when there are 
large numbers of clients viewing simultaneously. Note however, that a multicast broadcast 
cannot pass a network router unless the router is configured to allow this. It is thus not 
possible to multicast over e.g. the Internet. 

Unicasting should be used for video-on-demand broadcasting, so that there is no video 
traffic on the network until a client connects and requests the stream. However, if more 
and more unicast clients connect, the server will at some point become overloaded. There 
is also a maximum of 20 simultaneous viewers to be considered.

RTP/RTSP
This unicast method is RTP tunneled over RTSP. This can be used to exploit the fact that it 
is relatively simple to configure firewalls to allow RTSP traffic.

RTP/RTSP/HTTP or RTP/RTSP/HTTPS
These two methods can also be used to traverse firewalls. Firewalls are commonly 
configured to allow the HTTP protocol, thus allowing RTP to be tunneled.

Other methods of accessing the video stream
Video/images from the Axis video server can also be accessed in the following ways:

• If supported by the client, the Axis video server can use Motion JPEG server push 
to display video. This option maintains an open HTTP connection to the web 
browser and sends data as and when required, for as long as required. 

• As single JPEG images in a browser. Enter e.g. the path: 
http://<ip>/axis-cgi/jpg/image.cgi?resolution=CIF

• Windows Media Player. This requires AMC and the MPEG-4 decoder to be 
installed. The paths that can be used are listed below, in the order of preference.

• Unicast via RTP: axrtpu://<ip>/mpeg4/#/media.amp
• Unicast via RTSP: axrtsp://<ip>/mpeg4/#/media.amp
• Unicast via RTSP, tunneled via HTTP: axrtsphttp://<ip>/mpeg4/#/media.amp 
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• Unicast via RTSP, tunneled via HTTPS: axrtsphttps://<ip>/mpeg4/#/media.amp 
• Multicast:  axrtpm://<ip>/mpeg4/#/media.amp

Notes: • <ip> = IP address.
• # = video source number or the quad stream. This is set to 1 if omitted.

Other MPEG-4 clients
Although it may be possible to use other clients to view the MPEG-4 stream, it is not 
guaranteed to work in all cases. 

For some other clients, e.g. QuickTime™ the Video Object Type must be set to Simple. It 
may also be necessary to adjust the advanced MPEG-4 settings.

To access the video stream from e.g. QuickTime™ the following path can be used:

rtsp://<ip>/mpeg4/#/media.amp 

This path is for all supported methods, and the client will negotiate with the Axis video 
server to determine exactly which transport protocol to use.

Notes: • <ip> = IP address.
• # = video source number or the quad stream. This is set to 1 if omitted.

Audio transmission methods
The audio stream can be accessed in the Live View page when viewing either Motion JPEG 
or MPEG-4. 

Using Motion JPEG
The basic transmission method of audio used in conjunction with Motion JPEG video 
streaming is transmission over HTTP. The video and audio streams are not synchronized 
when using Motion JPEG so the streams may be slightly out of sync. The latency in any 
stream should be low, but this will depend on the network infrastructure.

Using MPEG-4

When using MPEG-4, audio is streamed using the same protocol as the video stream.

When audio is transmitted using MPEG-4, the Axis video server sends synchronization 
information along with the streams to the client performing the synchronization. 

Note: Audio is streamed from the client to the server over HTTP when using Motion JPEG and MPEG-4.
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Accessing the audio streams
In addition to accessing audio in the Live View page using AMC, audio from the AXIS 
241QA/241SA can also be accessed in the following ways:

AXIS VAPIX API
You can read about accessing audio for the other protocols through the AXIS VAPIX HTTP 
API at www.axis.com/techsup

QuickTime/Windows Media Player
It is possible to use QuickTime and Windows Media Player to listen to the audio stream 
using the same methods to access video streams.

Java Applet
The Java applet supports simplex audio.
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Configuring the video server
This section describes how to configure the Axis video server and is intended for:

• administrators, who have unrestricted access to all the Setup tools
• operators, who have access to the settings for Video & Image, Audio, Live View 

Config, Event, PTZ and IV (AXIS 242S IV only).
The Axis video server is configured from the Setup link, in a standard web browser. For 
more information on supported browsers, see the Technical specifications, on page 66.

Accessing the Setup tools
Follow the instructions below to access the Setup Tools from a web browser.

1. Start the browser and enter the IP address or host name of the Axis video server 
in the location/address field.

2. The Live View page is now displayed. Click Setup to display the Setup tools.

Setup tools
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Video & image settings
The following descriptions show examples of the available features in the Axis video 
server. For details of each setting, please refer to the online help available from each page. 
Click to access the online help.

Image settings

Image appearance
Modify the Image Appearance to optimize the video images according to your 
requirements.

All configuration of images and overlays will affect the performance of the video server, 
depending on the usage and the available bandwidth.

• High resolution generates larger files
• Lower compression improves image quality, but generates larger files
• Black & White uses less bandwidth than Color
• Rotating the image 90 or 270 degrees will lower the maximum frame rate

See also the specifications for frame rates and bandwidth on page 70. 
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Text overlay settings
Include date, time and/or text of your choice to be viewed on the image. The color of the 
text may be set to white or black, while background color may be set to white, black, 
transparent or semitransparent. The position of the text is set either to the top or the bot-
tom of the image. 

Video stream
The Maximum video stream time can be set as Unlimited, or set a maximum stream time 
per session in seconds, minutes or hours. When the set time has expired, a new stream on 
the Live View page can be started by refreshing the page in the web browser. Note that the 
maximum video stream time does not apply to clients connecting via multicast.

To avoid bandwidth problems on the network, the frame rate allowed to each viewer can 
also be limited. Select either Unlimited or define a maximum frame rate per viewer.

Test
For a preview of the image and overlay settings before saving, click Test. When you are 
satisfied with the settings, click Save.

Video source settings
These settings allow you to:

• enter a descriptive name for the video source (AXIS 241Q/QA only)
• eliminate any black borders surrounding the image, by making Offset adjust-

ments. See the online help for more information.

AXIS 242S IV and AXIS 241S/SA only: 

Select the physical connector the video source is connected to, BNC or Y/C. 

• BNC (composite video) connects a standard video camera or other video equip-
ment 

• Y/C (S-video) connects a Y/C (S-Video) camera or other video equipment 
 
On the AXIS 241S/SA, the video type can be converted from composite video to Y/C 
(S-Video) by using a Y/C to BNC cable. See page 60 for more information. See also the dip 
switch settings on page 9.

The AXIS 242S IV supports Y/C video directly on the S-Video connector.
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Overlay/Mask settings

Text
overlay

Image
Overlay

Overlay/Mask type
Overlay/Mask type allows you to 
place an overlay, or up to three pri-
vacy masks over the video image:

• Upload and place an 
image as an overlay - 
usually used to provide 
extra information in the 
video image.

• Place up to 3 config-
urable privacy masks to 
conceal different areas of 
the video image.

Selecting the overlay/mask type from the menu will display further settings available for 
the selected type. See the online help for further information.

Note: A privacy mask cannot be bypassed, but an overlay image can be bypassed with the help of the AXIS VAPIX 
API.

Upload and use an overlay image

1. Select Uploaded image as overlay in the drop-down list for Overlay/Mask Type. 
New options appear.

2. In the field Upload own image, click the Browse button and locate the image file 
on your computer or server. 

3. Click the Upload button and follow the on-screen instructions.

To use an already uploaded image:

1. Select an uploaded image from the Use image drop-down list.

2. Place the image at the required location by entering the x and y coordinates.

3. Click Save.
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Overlay image requirements:

Overlay image limitations:
• The maximum overlay image size supported by the Axis video server is the same 

as the maximum image resolution. See the Technical Specifications, on page 66.
• When a text overlay is also used, this reduces the amount of space available to 

the overlay image. To keep the text readable at lower resolutions, the text overlay 
occupies proportionally more of the image at lower resolutions. 

• If the overlay is initially positioned so that part of it is outside the video image, it 
will be relocated so that it appears over the video image, i.e. it is always the entire 
image that is displayed.

Please see the online help for more information.

Use a Privacy Mask
To use privacy masks to hide different areas of the video image:

1. Select Configurable areas as privacy mask in the drop-down list for 
Overlay/Mask Type. New options appear.

2. Enter the (x,y) coordinates of the top left hand corner of the mask, and the height 
and width to define the masks’ placement and size.

3. Select the privacy masks’ color: black, grey, white, or red.

4. Click in the box beside Enable to enable one or more of the masks you have 
defined and click on Save.

Image Formats Image Size

• Windows 24-bit BMP (full color)

• Windows 4-bit BMP (16 colors)

The height and width of the overlay image in 
pixels must be exactly divisible by 4.
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Advanced - MPEG-4 settings
Tools for adjusting the MPEG-4 settings and for controlling the video bit rate. 

The MPEG-4 standard provides many different coding tools for various applications in 
different situations. As most MPEG-4 clients do not support all of these tools, it is usual to 
instead define and use subsets for different clients or groups of clients. These settings allow 
you to define the type of viewing client to use.

Adjusting the maximum bit rate and setting it to variable or constant is a good way of 
controlling the bandwidth used by the MPEG-4 video stream.

For more information on these advanced settings, please see the online help.

Quad stream settings (AXIS 241Q/QA only)
These settings are the same as for individual image settings, but are active only when the 
quad stream view is selected, see Image settings, on page 20.
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Audio (AXIS 241QA/SA only)
The AXIS 241QA/SA can transmit audio to other clients using an external microphone and 
can play audio received from other clients by attaching a speaker. The Setup page for the 
AXIS 241QA/SA has an additional menu item called Audio, which allows different audio 
configurations to be set up, e.g. full duplex, half duplex and simplex.

Note: The speaker attached to the audio output of the AXIS 241QA/SA must have a 
built-in amplifier, which is the case for e.g. some PC speakers.

Audio Settings
This section describes how to configure the basic audio settings for the AXIS 241QA/SA, 
e.g. set the communication mode and adjust the sound levels in the microphone and 
speaker connected to the camera. 

Enable Audio

Select the video sources that the AXIS 241QA/SA will transmit and receive audio from.

Audio Channels

There are two mono audio channels between the AXIS 241QA/SA and each connected 
client, one for receiving audio and the other for transmitting audio. Each audio channel 
can be turned on or off, which means there are four audio mode options that can be used.
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Full-duplex mode means that you can transmit and receive audio (talk and listen) at the 
same time, without having to use any of the controls. This is just like having a telephone 
conversation. The only controls you may wish to use are the mute buttons to turn off the 
sound, and the sliders, to adjust the input/output volume levels. This mode requires that 
the client PC has a sound card with support for full-duplex audio. If your available 
bandwidth is 0.2 Mbit/s or less, it is recommended that you use Half-duplex mode instead.

Half-duplex mode also transmits and receives audio in both directions, but only in one 
direction at a time. This means that you must select when to receive or transmit audio with 
the help of the push-to-talk button. To speak, press and hold the button (check that the 
microphone is not muted). When finished speaking, release the button. You will now be 
receiving audio from the other end of the connection. 

Note that the push-to-talk button is configured from AMC, see AXIS Media Control (AMC), 
on page 15. It is also possible to configure the push-to-talk button so that it toggles 
between speaking and listening modes. Half-Duplex mode is best if you only have limited 
bandwidth available.

When selecting Simplex - AXIS 241QA/SA speaker only mode, the speaker connected to 
the AXIS 241QA/SA will play audio, but no audio will be transmitted from the AXIS 
241QA/SA to other web clients. This could be used to e.g. provide spoken instructions to a 
person seen in a camera. This mode requires you to use the push-to-talk button.

Simplex - AXIS 241QA/SA microphone only mode only transmits audio from the AXIS 
241QA/SA to any web clients. It will not receive audio from any other web clients. This 
can be used in remote monitoring, web attractions etc., to provide live audio, as well as 
video, of a monitored situation.

When using half-duplex, the Send the sound from the active client to all other clients 
option transmits the audio signal from the client that is talking to all the other clients. 

Audio Input

Audio from an external microphone or a line source can be connected to the Line/Mic In 
jack of the AXIS 241QA/SA. The audio source can be set to Microphone or Line. If you are 
using a microphone, the input sensitivity can be set to High or Low. See Technical 
specifications, on page 66 for the exact maximum levels.

The Enable microphone power option provides DC power for the external microphone. If 
you use a small electret condenser microphone such as a clip-on mic or a PC microphone, 
this option needs to be enabled. 

To use a high impedance dynamic microphone, DC power should not be enabled. DC power 
will not harm the microphone, but if you are uncertain, try switching it off and on. DC 
power is enabled by default. To use a professional microphone requiring 48V phantom 
power, you need an external power supply and must use a balanced-unbalanced converter 
(audio transformer) in between. 
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If there are problems with the sound input being too low or high, it is possible to adjust the 
input gain for the microphone attached to the AXIS 241QA/SA.

Audio Output

If the sound from the speaker is too low or high it is possible to adjust the output gain for 
the active speaker attached to the Axis video server. 

When satisfied with the settings, click Save, or click Reset to revert to the previously saved 
settings.

Advanced Audio Settings

The Advanced Quality Settings allows you to tune the audio input to suit your 
environment.

Enable speech filter improves the sound quality if using a microphone that is placed close 
to the person talking and can also help reduce background noise. The filter cuts the lowest 
and the highest frequencies. The bypass frequency range is approximately 250Hz to 
3700Hz (measured at -10dB cut-off points).

Enable echo cancellation can reduce the feedback generated when using full duplex. If 
sound distortion is encountered, turning echo cancellation off may improve the sound 
quality.

Noise cancelling is a way of reducing the background noise when there is no useful audio 
present. A typical application could be when there is a noisy environment and you are only 
interested in hearing the sound when someone is speaking close to a microphone. There are 
two adjustable parameters available to optimize this function:

• Noise canceller threshold value 
• Noise canceller attenuation 
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When the incoming sound is louder than the threshold, it will pass without any changes. 
When lower than the threshold, the incoming sound will be reduced by a certain 
attenuation factor. The threshold value should be set higher than the background noise, 
but lower than the useful audio. 

The noise canceller threshold value can be set to High, Medium High, Medium low and 
Low. A lower threshold will accept most of the audio to pass. Only the weakest 
background noise will be reduced. A higher threshold will make the noise canceller act on 
even stronger background noise. At the maximum level High, there is a risk of reducing 
useful audio as well. 

There is a trade-off between noise cancelling and sound quality. In other words, increasing 
the noise canceller attenuation deteriorates sound quality. Adjust the threshold and the 
attenuation to an optimum by listening and changing the levels.
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Live View Config

Layout
These are the tools for deciding the layout 
of the Live View page. 

The layout can be set in 3 ways:

• Use Axis look - the layout is 
unchanged.

• Use custom settings - modify the 
default page with your own col-
ors, images etc. Click the Config-
ure button and see the following 
page.

• Own Home Page - Upload and 
use your own custom made page 
as the default web page. Click the 
Configure button and see the fol-
lowing page.

The other settings on this page concern 
which other features to include on the Live 
View page, e.g. buttons and links. See 
page 31 for more information.
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Customizing the 
default page
The appearance of 
the default Axis 
video server Live 
View page can be 
customized to suit 
your own 
requirements, or you 
can upload and use 
your own home 
page. To upload your 
own files, click the 
Upload/Remove 
button and see the 
description below.

Upload Own Web 
Files
Your own web files, background pictures, etc. must first be uploaded to the Axis video 
server in order to be available for selection in the Custom Settings setup dialog. Once 
uploaded, the files are shown in the drop-down list.

1. Enter the path to the file, e.g. a file located on your workstation or click the 
Browse button.

2. Select the user level for the uploaded file. Setting the user access level means that 
you have complete control over which pages can be viewed by which users.

3. When the path is shown correctly in the text field, click the Upload button. 
Uploaded files are now shown in the list in the lower section of the page.

4. To use your uploaded file, click the radio button and select the file from the 
drop-down list by Own.

To remove a file, check the box provided next to it and then click the Remove button.

To use an external file located somewhere other than in the Axis video server, select this 
radio button and enter the URL in the field marked External.

Own Home Page
To use a previously uploaded web page as the default page, check the checkbox, select the 
page from the drop-down list and click OK.

Default Live View Video (AXIS 241Q/QA only)
Select a single video source or the quad view to use as the default view on the Live View 
page.

Note that the setup address is http://<ip address>/operator/basic.shtml
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User-defined Links 
Enter a descriptive name and enter the URL in 
the field provided. The link will appear on the 
Live View page.

User defined CGI links can be used to issue 
HTTP API requests, e.g. PTZ commands. 
Example:

1. Check Show Custom Link 1

2. Enter a descriptive name, e.g. CAM1 Start 
PTZ.

3. Enter the cgi link: 
http://192.168.0.125/axis-cgi/com/ptz.cgi?
camera=1&continuouspantiltmove=30,-30

4. Check Show Custom Link 2.

5. Enter a descriptive name, e.g. CAM1 Stop 
PTZ.

6. Enter the cgi link: 
http://192.168.0.125/axis-cgi/com/ptz.cgi?camera=1&continuouspantiltmove=0,0

7. These links will appear in the web interface and can be used to control the PTZ camera

For more information on the AXIS VAPIX HTTP API, see the Developer pages at the Axis 
web site www.axis.com/developer. See also the section on PTZ, on page 41.

Action Buttons
These buttons can be used to manually start and stop an event from the Live View page. 
See Event configuration, on page 36. The snapshot button allows you to take a snapshot of 
the video stream and save it to a computer.

Output Buttons
These buttons are used to control the outputs on the Axis video server and thus the 
equipment connected to them, e.g. to switch a light on or off:

• The Pulse button activates the port for a defined period
• Active/Inactive displays 2 buttons, one for each action (on/off)

Default Video Format
Select the default format to use on the Live View page. Checking the box for Show video 
format selection displays a drop-down list on the Live View page allowing you to 
temporarily change the format. 

Default Viewer
Select from the drop-down list the viewer you wish to use for your web browser. Please see 
the online help for more information.

User-defined links
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Viewer Settings

Checking the Show viewer toolbar box displays the AMC toolbar under the video stream 
in Microsoft Internet Explorer. 

By checking the Enable MPEG-4 decoder installation box, it is also possible for the 
Administrator to enable or disable the installation of the MPEG-4 decoder. This is used to 
prevent the installation of unlicensed copies. Further decoder licenses can be purchased 
from your Axis dealer.

Show crosshair in PTZ joystick mode - This will enable the display of a crosshair in the 
video image when the the PTZ mode is set to joystick.

Show IV SVG data in image stream (AXIS 242S IV only) - The currently running IV 
module is capable of showing SVG data superimposed over the video image. 

HTML Examples
Live video from the Axis video server can be added to your own web page. 

Select the preferred Video Format from the drop down list. The available options are 
Motion JPEG, MPEG-4 using AMC and MPEG-4 using QuickTime. If MPEG-4 using AMC is 
set as the video format, note that a separate MPEG-4 license is required for each viewer.

The Motion JPEG selection has additional settings for Image Type, Image size and other 
optional settings for configuring the video stream to suit your web page. Click Update 
when satisfied. 

The video server then generates the required source code for your configuration. Copy this 
code and paste it into your own web page code.

External Video
You can add links to other Axis network devices available over the network. These sources 
can be displayed on the Live View page, just as if they were video sources connected 
directly to the Axis video server.

Click the Add button to open the External Video Source Setup dialog, which is used to 
make all the necessary settings.

Example of a path to an external video source:

http://192.168.0.125/axis-cgi/mjpeg/video.cgi
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Sequence Mode
The live view page can be configured to rotate through selected internal and/or external 
video sources, in order or randomly. PTZ preset positions can also be included.

Select the desired video sources and enter the time in seconds to display each source (up to 
59 minutes). Click Save.

The Sequence buttons will appear on the Live View page to allow the viewer 
to start and stop the sequence mode.

Please see the online help for more information.
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Intelligent Video
The AXIS 242S IV Video Server is a 1-channel video server equipped with a Digital Signal 
Processor (DSP) that makes it possible to add advanced video/audio applications, such as 
people counting, trip wire detection and other advanced solutions. 

This section describes how to upload and select Intelligent Video (IV) modules in the AXIS 
242S IV. For more information on how to configure individual IV modules, see the 
documentation supplied with the module, or see the video server’s online help.

Module upload
To use an IV application in the AXIS 242S IV, the IV module must first be uploaded. If 
your video server was supplied with an IV module preloaded, this section can be skipped.

To upload a new IV module, enter the file name and path to it in the text field provided, or 
click the Browse button to locate the file and then click the Upload button. Once uploaded 
the module will be available for selection in the IV module list.
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Running IV module 
This shows the IV module currently running in the AXIS 242S IV Video Server. Only one 
IV module can run at any one time. The loaded module will also show one or more 
function buttons. Exactly which buttons are displayed is module-dependent, with the 
exception of the Stop button, which is always available. 

• Stop - the module is disabled, no other is started.
• Edit parameters - opens a new window that provides access to all of the module’s 

available settings.
• Status - opens a new window showing statistics, results or other information, 

depending on the IV module.

Module list  
The IV module list shows the currently uploaded IV modules. The maximum number that 
can reside in the AXIS 242S IV at any one time is only limited by the amount of flash 
memory available. 

To start an IV module from this list, select it and click the Start button. This will 
automatically stop any other IV module currently running. 

To remove a module, select it in the list and click the Remove button. The module does not 
need to be stopped before being removed. 

To see the available information for the module, select it in the list and click the About... 
button.
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Event configuration
This section describes how to configure the Axis video server for alarm handling. Various 
actions can be configured to run when certain types of events occur.

A set of parameters describing how and when the video servervideo server is to perform certain 
actions

- the circumstances that start an event e.g. at a signal from an external device, such as a door 
switch or a motion sensor

- the circumstances that start an event e.g. at a pre-programmed time

- what occurs when the event runs e.g. video images uploaded to an FTP server, email noti-
fication sent, etc.

Event servers
Event Servers are used for e.g. receiving uploaded image files and/or notification 
messages. To set up Event server for your Axis video server, go to Setup > Event 
Configuration > Event Servers and enter the required information according to the 
selected server type.

For details on each setting, please refer to the online help available from each web 
page.

Note: The images in pre-trigger and post-trigger buffers will be lost if the connection to the event server fails.

When the setup is complete, the connection can be tested by clicking the Test button (the 
test takes approximately 10 seconds). 

Event type

Triggered Event (see page 37)

Scheduled Event (see page 38)

Action

Server type Purpose Information required

FTP Server

• receives uploaded images • Descriptive name of your choice
• User Name and Password (to FTP server)
• Upload path, e.g. images/
• Port number
• Use passive mode if there is a firewall between the video 

server and FTP server
• Use a temporary file if your FTP server does not allow an 

existing file to be overwritten by a new file with the same 
name.

HTTP Server

• receives notification messages
• receives uploaded images

• Descriptive name of your choice
• URL (address)
• User Name and Password (to HTTP server)
• Proxy address/Proxy port (if required)
• Proxy User Name and Password (if required)

TCP Server 
• receives notification messages • Descriptive name of your choice

• User Name and Password (for TCP server)
• Port number
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Event types
An event type is a set of 
parameters describing how 
and when the video server 
is to perform certain 
actions.

Example: If somebody walks past 
the connected camera, and an event 
has been configured to act on this, 
the video server can e.g. record and 
send video images to an FTP server, or send a notification email to a pre-configured email address with a pre-con-
figured message. Video images can be sent as an attachment with the email.

Triggered Event
A triggered event is activated by e.g:

• a pushbutton connected to an input port on the video server
• detected movement in a configured motion detection window
• a lost signal from a video source
• a manual action e.g. clicking the trigger button in the web interface
• on restart (reboot) after e.g. power loss
• a trigger from the currently running IV module (AXIS 242S IV only).

How to set up a triggered event
This example describes how to set the Axis video server to upload images when the main 
door is opened:

1. Click Add triggered on the Event types page.

2. Enter a descriptive name for the event, e.g. Main door.

3. Set the priority - High, Normal or Low (see online help files).

4. Select the Video Source the event is to act on, e.g. Video 1 on Main door (AXIS 
241Q/QA only).

5. Set the Respond to Trigger... parameters when the event is to be active, 
e.g. only after office hours

6. Select the trigger alternative from the Triggered by... drop-down list, 
e.g. an Input port with a connected sensor if the door is opened.

7. Set the When Triggered... parameters, i.e. set what the video server should do if 
the main door is opened, e.g. upload images to an FTP server.

8. Click OK to save the event in the Event Types list.

Please see the online help for descriptions of each available option.
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Pre-trigger and post-trigger buffers
This function is very useful when checking to see what happened immediately before and 
after a trigger, e.g. 2 minutes before and after a door was opened. Check the Upload 
images checkbox under Event Types > Add Triggered... > When triggered... to expand 
the web page with the available options.

Buffer size - AXIS 242S IV and AXIS 241Q/QA - up to 36 MB buffer; AXIS 241S/SA - up 
to 9 MB buffer.  
The maximum length of time of the pre-/post-buffer depends on the selected image size 
and frame rate.

Include pre-trigger buffer - images stored internally in the server from the time 
immediately preceding the trigger. Check the box to enable the pre-trigger buffer, enter the 
desired length of time and specify the required image frequency. 

Include post-trigger buffer - contains images from the time immediately after the trigger. 
Configure as for pre-trigger. 

Note: If the pre- or post-buffer is too large for the Axis video server's internal memory, the frame rate will be 
reduced and individual images may be missing. If this occurs, an entry will be created in the unit's log file.

Continue image upload (unbuffered) - enable the upload of images for a fixed length of 
time. Specify the length of time for the uploaded recording, in seconds, minutes or hours, 
or for as long as the trigger is active. Finally, set the desired image frequency to the 
maximum (the maximum possible) or to a specified frame rate. The frame rate will be the 
best possible, but might not be as high as specified, especially if uploading via a slow 
connection.

Scheduled event
A Scheduled event can be activated at pre-set times, in a repeating pattern on selected 
weekdays.

How to set up a scheduled event
This example describes how to set the video server to send an email notification with saved 
images from a set time:

1. Click Add scheduled on the Event types page.

2. Enter a descriptive name for the event, e.g. Scheduled email.

3. Set the priority (High, Normal or Low).

4. Select the video source i.e. the source the event should act on, 
e.g. Video 2 in Storage room (AXIS 241Q/QA only).

5. Set the Activation Time parameters (24h clock) when the event should be active, 
e.g. start on Sundays at 13.00 with a duration of 12 hours.

6. Set the When Activated... parameters i.e. set what the video server should do at 
the specified time e.g. send uploaded images to an email address.
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7. Click OK to save the Event in the Event Types list.

Please see the online help for descriptions of each available option.

Motion detection
In the Motion Detection menu, you can configure the video source(s) for motion detection. 
The motion detection feature is used to generate an alarm whenever movement occurs (or 
stops) in the image. The AXIS 241Q/QA can use a maximum of 40 Include/Exclude 
windows, whilst the AXIS 242S IV/AXIS 241S/SA can use a maximum of 10.

• Include windows target specific areas within the image
• Exclude windows are areas to be ignored within the Include window

Once configured, the motion detection windows will appear in a list when motion 
detection is selected to trigger an event. See How to set up a triggered event above.

Note: Using the motion detection feature may decrease overall performance in the video server.

How to configure Motion Detection
This example describes how to configure motion detection:

1. Click Motion Detection in the Event Configuration menu.

2. Select Video Source from the menu (AXIS 241Q/QA only).

3. Click the Configure Included Windows radio button.

4. Click New.

5. Enter a descriptive name of your choice under Windows name.
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6. Adjust the size (drag the bottom right-hand corner) and position (click on the text 
at the top and drag to the desired position).

7. Adjust the Object size, History and Sensitivity profile sliders (see table below for 
details). Any detected motion within an active window is then indicated by red 
peaks in the Activity window (the active window has a red frame).

8. Click Save.

Please use the online help for descriptions of each available option.

High Only very large objects 
trigger motion detection

An object that appears in the region will 
trigger the motion detection for a long 
period

Ordinary colored objects against ordinary 
backgrounds will trigger the motion 
detection

Low Even very small objects 
trigger motion detection

An object that appears in the region will 
trigger motion detection for only a very 
short period

Only very bright objects against a dark 
background will trigger motion detection

Default values Low Medium to High Medium to High

Examples: 

• Avoid triggering on small objects in the image by selecting a high size level.
• To trigger motion detection as long as there is activity in the area, select a high history level.
• To only detect flashing light, low sensitivity can be selected. In other cases, a high sensitivity level is 

recommended.

Port status
Under Event Configuration > Port Status, there is a list that shows the status for the 
connected inputs and outputs of the Axis video server. This is for the benefit of an 
operator, who cannot access the System Options section.

Example: If the Normal state for a push button connected to an input is set to Open circuit, as long as the button is 
not pushed, the state is inactive. If the button is pushed, the state of the input changes to active.

If there are parts of the Include window that you wish to exclude, click the 
Configure Excluded Windows radio button and perform steps 1-6 above. 
Click Save.

Parameter Object Size History Sensitivity
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Pan Tilt Zoom 

Installing PTZ devices
The Axis video server supports several PTZ devices. Please see www.axis.com for a 
complete list of supported devices, and to obtain the correct driver. Follow the instructions 
below to install a PTZ device:

1. Using an appropriate cable, connect the device to your selected port (RS-232 or 
RS-485). These ports are available via the D-Sub connector and the I/O terminal 
connector, respectively. See pages 57 and 59 for more information.

2. In the setup tools, go to Setup > System Options > Ports & Devices and then 
select either port RS-232 or RS-485 to configure. See the figure below.

3. Select Pan Tilt Zoom from the Usage drop-down list.

4. Click Upload to install a PTZ driver. 
(PTZ drivers are available from the Axis Web site at www.axis.com)

5. Click Port Options... to modify the port settings. The default values correspond to 
the values specified by the PTZ driver.

6. From System Options > Ports & Devices, select the port configured for PTZ and 
then select the video source to use with the device.

7. If required, click the Advanced Options button to make further settings and see 
the online help.
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Note: Advanced users and application developers can also use the Axis Application Programming Interface and 
HTTP specification for generic control of PTZ devices using CGI commands or a TCP/IP client. Please refer to 
the Axis Website at www.axis.com for further information.

PTZ configuration
Once PTZ has been installed for the Axis video server, PTZ Configuration now appears in 
the menu to the left along with the following sub menus.

Preset positions 
A preset position is a pre-defined camera view than can be used to quickly move the 
camera to a specific location.

From Preset Position Setup, use the Pan, Tilt and Zoom (PTZ) controls to steer the camera 
to the required position. When satisfied with the camera's position, enter a descriptive 
name. The camera position, iris and focus settings are then saved as a preset position.

The position can be assumed at any time, by selecting the preset's name from the Preset 
positions drop-down list. Preset positions can be selected in Live View, from events and in 
Sequence mode.

One position can be set as the Home position, which is readily accessible by clicking in the 
box beside Use current position as Home. The position's name will then have (H) added to 
the end, e.g. Office Entrance (H).
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PTZ controls
If the Axis video server has been appropriately configured, the Live View page will display 
the controls available for the installed Pan Tilt Zoom (PTZ) device. The administrator can 
enable/disable the controls for specified users.

Video sources

Preset positions

Tilt bar (relative)

The exact controls shown depends on the make and model of PTZ device. There may be 
e.g. Focus and Iris bars available as well, but the most common controls are;

• the Pan bar - moves the camera to the right and left 
• the Tilt bar - tips the camera up and down
• the Zoom bar - zooms the view in and out. Note that this is only available if the 

camera is fitted with a zoom lens.
• the Iris bar - adjusts the brightness of the image

Clicking on the bars themselves or on the arrows at the end of the bars will move the 
camera to a new position. The type of movement and the location of this new position 
depends on the type of PTZ driver. 

When controlling the camera using a relative PTZ driver (see the bars in the illustration 
above) the new position will be relative to the previous position, e.g. left of, below, above, 
etc. Clicking the bar further from the center results in a larger movement. 
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In contrast, when using an absolute driver, each 
position on the bar (see right) represents a defined 
position in the device’s range of movement, with the center of the bar representing the 
point midway between the two extremes of movement.

Clicking a position directly on the bar moves the camera directly to the new position in 
one smooth movement. Clicking on the arrows at the ends of a bar causes a stepped, 
incremental change. 

Using CGI links to control PTZ devices
User-defined CGI links on the Live View page can be used to issue HTTP API requests, e.g. 
PTZ commands. These links are configured in the Live View Layout settings, see page 11.

PTZ control modes
The PTZ device can also be controlled using click-in-image movement, which has two 
different types of navigation; Center and Joystick.

Center mode means that when clicking in the image, the camera view will center on the 
absolute position that was clicked.

Joystick mode moves the camera in the direction of the mouse pointer. By clicking and 
holding the mouse button down in the image, the PTZ device moves the camera in that 
direction, relative to the center of the image. The further from the center the image is 
clicked, the greater the movement. The camera stops moving when the button is released. 

Control panel
The focus and iris (image brightness) can be adjusted manually by using the control bars, 
or they can be set for automatic adjustment, by clicking the Auto iris and Auto focus 
buttons.

To access the Auto iris and Auto focus buttons, click on the Control 
panel button. The menu to the right will then appear in the upper left 
hand corner of the screen.

There are also driver specific shortcuts that can appear in the Control 
Panel. In the screen to the right, a driver has been installed that 
brings up the Wiper shortcut button, which allows the user to 
configure and use a windshield wiping action with the Axis video 
server.
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Preset positions

Also available with many PTZ devices are Preset positions. These presets are selected from 
the drop-down Source list on the Live View page and will move and/or zoom the camera 
to a pre-defined position, i.e. to cover an area of particular interest. Events can also be 
configured to go to preset positions when triggered. For information on setting up preset 
positions, please see Preset positions, on page 42 and the online help.

Guard tour
A guard tour moves between chosen Preset Positions, one-by-one, in a pre-determined 
order or randomly, and for configurable time periods. Unlike the Sequence Mode, which is 
a viewing application under Live View Config (see Live View Config, on page 29), the 
guard tour sequence will keep running after the user has logged off or closed the browser.

Advanced
Device Settings - The device settings window is for driver specific settings, so the 
appearance of this window can vary depending on the driver installed. Options that can be 
configured include: Driver Specific Settings for Video Source 1, Mechanical Limits for 
Moving Video Source 1, Light Control for Video Source 1, and Extended Driver Specific 
Settings for Video Source 1.

Ctrl Panel - The Panel View Settings window contains tools for creating and saving short 
command buttons that are located under the Control panel. These buttons provide direct 
access to various built-in auxiliary commands provided by the PTZ driver and are 
displayed in the PTZ Panel.

Limits - Define the pan, tilt, zoom and focus limits for the Axis video server. Movements to 
the left and right, up and down can be restricted to narrow the area under surveillance. The 
near focus limit can be set to avoid focusing on objects too close to the camera.
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OSD Menu - If the PTZ unit supports an internal configuration menu, this can be accessed 
using the On-Screen Display (OSD). Configure the analog camera by opening and 
navigating through its internal menu in this display.

PTZ control queue 
Use the PTZ control queue window to enable and disable PTZ queueing. This window 
allows you to set up a queue for viewers wanting to access the Axis video server, and 
limits the number of viewers and the length of time each viewer can access and control the 
PTZ unit. For more information on how to set up the control queue, please see the online 
help.

Note also that a viewer who belongs to a group (see Security, on page 48) with a higher 
PTZ priority can go before other users in the queue and take control of the Axis video 
server. 
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The order of priority for taking control of the queue is as follows:

1. Administrators - An administrator takes over PTZ control regardless of who is 
currently first in queue. The administrator will be removed from the queue 60 
seconds after their last PTZ control command.

2. Event - The Axis video server can be set up to take control of the queue and 
move to a specific position for 20 seconds when triggered by an alarm. The event 
will immediately be placed first in the queue, except when an administrator is in 
control. For more information, see Triggered Event, on page 37.

3. Operator - Same as administrator, but with lower priority.

4. Guard Tour - A guard tour has PTZ control for an indefinite period of time. It 
may be overridden by; Operator, Event or administrator. Guard Tour will resume 
when higher priority groups leave the queue. For more information see Guard 
tour, on page 45.

5. Viewer - Multiple viewers must wait for their turn. The viewer has 60 seconds 
PTZ control before control is passed to the next viewer in queue. 

Note: In order to identify different users in the viewer group, cookies must be enabled on the client.
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System options

Security
User access control is enabled by default, when the administrator sets the root password on 
first access. New users are authorized with user names and passwords, or the administrator 
can choose to allow anonymous viewer login to the Live View page, as described below:

Users - the user list displays the authorized users and access levels:

Provides the lowest level of access, which only allows the user access to the Live View page
An Operator can view the Live View page, create and modify event types and adjust certain other 
settings. The Operator does not have access to the Systems Options configuration pages.
An administrator has unrestricted access to the Setup Tools and can determine the registration of 
all other users. 

User settings - check the corresponding checkboxes to enable:

• Anonymous viewer login - allows any viewer direct access to the Live View 
page.

• Anonymous PTZ control login - allows any viewer access to the Pan Tilt Zoom 
controls on the Live View page (if Pan/Tilt/Zoom is available).

IP address filtering
Checking the Enable IP address filtering box enables the IP address filtering function. Up 
to 256 IP address entries may be specified (a single entry can contain multiple IP 
addresses). Click the Add button to add new filtered addresses.

When the IP address filter is enabled, addresses added to the list are set as allowed or 
denied addresses. All other IP addresses not in this list will then be allowed or denied 
access accordingly, i.e. if the addresses in the list are allowed, then all others are denied 
access, and vice versa. See also the online help for more information.

Note that users from IP addresses that will be allowed must also be registered with the 
appropriate access rights (User, Operator or Administrator). This is done from Setup > 
System Options > Security > Users. 

Referrals - to prevent unauthorized sources from including the video stream from the Axis 
video server into external Web pages, check the Referrals box and enter the IP address or 
Host name of the computer that hosts the Web pages with the included video stream. 
Multiple IP addresses/host names can be defined and are separated by semicolons(;)

Viewer

Operator

Administrator
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Notes: •If the referrals feature is enabled and you wish to also allow normal access to the Live View 
page, the product's own IP address or host name must be added to the list of allowed referrers.

•Restricting referrers has no effect on an MPEG-4 video stream. To restrict an MPEG-4 stream, IP 
address filtering must be enabled.

•Restricting referrers is of greatest value when not using IP address filtering. If IP address filter-
ing is used, then the allowed referrers are automatically restricted to those allowed IP 
addresses.

HTTPS
For greater security, the Axis video server can be configured to use HTTPS (Hypertext 
Transfer Protocol over SSL (Secure Socket Layer)). That is, all communication that would 
otherwise go via HTTP will instead go via an encrypted HTTPS connection.

Certificate - to use HTTPS for communication with the Axis video server, a Certificate 
must be created using one of these methods:

• A self-signed certificate can be created in the video server, but this does not guar-
antee the same level of security as an official certificate.

• An official certificate issued by a CA (Certificate Authority). A CA issues and 
manages security credentials and public keys for message encryption.

1. Click either Create self-signed certificate or Create Certificate Request and enter 
the required information in the provided fields

2. Click OK.

3. Create self-signed certificate generates and installs a certificate which will be 
displayed under Installed Certificate. 
Create Certificate Request generates a PEM formatted request which you copy 
and send to a CA for signing. When the signed certificate is returned, click Install 
signed certificate... to install the certificate in the Axis video server.

4. Set the HTTPS Connection Policy for the administrator, Operator and Viewer to 
enable HTTPS connection (set to HTTP by default)

Please refer to the home page of your preferred CA for information on where to send the 
request etc. For more information, please see the online help

Date & time
Current server time - displays the current date and time (24h clock). The time can be 
displayed in 12h clock format in overlay images.

New server time - Select your time zone from the drop-down list and check the daylight 
saving time changes, if desired. 



 50 Axis video server - System options
From the Time Mode section, select the preferred method to use for setting the time:

• Synchronize with computer time - sets the time from the clock on your com-
puter. 

• Synchronize with NTP Server - the video server will obtain the time from an 
NTP server every 60 minutes. Specify the NTP server's IP address or host name.

Note: Note that if using a host name for the NTP server, a DNS server must be configured under TCP/IP settings. 
See Network > Advanced TCP/IP Settings below.

• Set manually - this option allows you to manually set the time and date.
Date & time format used in images - specify the formats for the date and time (12h or 
24h) displayed in the Live View video streams.

Use the predefined formats or use your own custom date and time formats. See File 
Naming & Date/Time Formats in the online help for information on how to create 
your own date and time formats.

Network - Basic TCP/IP settings

IP address configuration
The IP address of the video server can be set automatically via DHCP, or a fixed IP address 
can be set manually. DHCP is enabled by default. To use a fixed IP address, you must also 
enter the correct subnet mask and default router.

Notes: •DHCP is a protocol for automatic IP address assignment on a network. IP address assignment via 
DHCP may lead to the situation where the IP address changes and you lose contact. Configure 
the options for notification of IP address change (under Services) to receive notification from 
the video server when the IP address changes.

•Alternatively, if your DHCP server can update a DNS server, you can access the Axis video server 
by host name which is always the same, regardless of the IP address.

Services
Options for notification of IP address change - if the IP address for the video server 
changes, e.g. automatically by DHCP, you can choose to be notified of the change. Click 
Settings... and enter the required information.

AXIS Internet Dynamic DNS Service - If the Axis video server has been registered with 
the Axis Internet Dynamic DNS service and the IP address for the product changes, the 
service is updated to reflect the change. Check the box to enable/disable automatic 
updates.

The domain name currently registered at the Axis Internet Dynamic DNS service for your 
product can at any time be removed. To do this click Settings... and follow the 
instructions. For more information, please refer to the online help
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Network - Advanced TCP/IP settings

DNS configuration
DNS (Domain Name Service) provides the translation of host names to IP addresses on your 
network.

Obtain DNS server address via DHCP - automatically use the DNS server settings provided 
by the DHCP server. Click the View button to see the current settings.

Use the following DNS server address - enter the desired DNS server by specifying the 
following:

Domain name - enter the domain(s) to search for the host name used by the Axis video 
server. Multiple domains can be separated by semicolons (;). The host name is always the 
first part of a Fully Qualified Domain Name, e.g. myserver is the host name in the Fully 
Qualified Domain Name myserver.mycompany.com where mycompany.com is the 
Domain name.

DNS servers - enter the IP addresses of the primary and secondary DNS servers.

NTP
Obtain NTP server address via DHCP - use a DHCP server to automatically find an NTP 
server to synchronize clock of the Axis video server with the other devices on the network

Use the following NTP server address - use the host name or IP address of a specific NTP 
server for time synchronization.

Host name configuration
The Axis video server can be accessed using a host name, instead of an IP address. The host 
name is usually the same as the assigned DNS Name.

For more information, please see the online help

Link-Local address
This is enabled by default and assigns the Axis video server an additional IP address for 
use with UPnP™. The Axis video server can have both a Link-Local IP and a static or 
DHCP-supplied IP address at the same time - these will not affect each other. 

HTTP 
The default HTTP port number (80) can be changed to any port within the range 
1024-65535. This is useful for e.g. simple port mapping.
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HTTPS 
The default HTTPS port number (443) can be changed to any port within the range 
1024-65535. This is useful for e.g. simple port mapping.

NAT traversal
Use NAT traversal when your video server is located on an intranet and you want to make 
it available from the other side of a NAT router.

RTSP
The RTSP protocol allows a connecting client to start an MPEG-4 stream. Enter the RTSP 
port number to use. The default setting is 554, and the allowed port range is 1024-65535.

Network traffic 
The default setting is Auto-negotiate which means that the correct speed is automatically 
selected. If necessary, you can set the connection speed by selecting it from the drop-down 
list.

Maximum bandwidth - Specify, in Mbit/s or kbit/s, the maximum bandwidth that the 
video server is allowed to use on your network. This is a useful function when connecting 
your video server to busy or heavily loaded networks. The default setting is Unlimited.

Note: When using MPEG-4 as the video format, remember that setting a maximum bandwidth value here may 
create problems for individual video streams if the maximum value is less than the sum of the bit rates set 
for the video streams. 

For more information, please see the online help

SOCKS 
SOCKS is a networking proxy protocol. The Axis video server can be configured to use a 
SOCKS server to reach networks on the other side of a firewall/proxy server. This 
functionality is useful if the video server is located on a local network behind a firewall, 
but notifications, uploads, alarms, etc., need to be sent to a destination outside the local 
network (e.g. to the Internet).

SMTP (email)
Enter the host names or addresses for your primary and secondary mail servers in the 
fields provided, to enable event and error email messages from the video server to 
predefined addresses, via SMTP. 

If the mail server requires SMTP authentication, check the box for Use authentication to 
log in to this server and enter the user name and password used for logging in. Several 
different methods of authentication are available. See the online help for more 
information. 
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SNMP
The Simple Network Management Protocol (SNMP) allows the remote management of 
network devices. Select the version of SNMP to use, depending on the level of security 
required. Select the version of SNMP to use, by checking the appropriate box. The three 
levels of security are:

• SNMP V1 - includes no security
• SNMP V2c - uses very simple security, e.g. community name as password
• SNMP V3 - provides encryption and secure passwords. Use with HTTPS. 

If using V1 and V2c, enter the community name for read-only access to all supported 
SNMP objects (except the root password and other objects that require write access). 
Default value = public. You can also specify the community name for read/write access to 
all supported SNMP objects (except read-only objects). Default value = pass. 

If using HTTPS enter the password if it has not already been set. To set the password again, 
the Axis video server must be reset to the factory default settings.

UPnP™
The video server includes support for UPnP™ in Windows ME and Windows XP. UPnP™ is 
enabled by default.

Note: UPnP™ must be installed on your workstation if running Windows XP. To do this, open the Control Panel 
from the Start Menu and select Add/Remove Programs. Select Add/Remove Windows Components and 
open the Networking Services section. Click Details and then select UPnP™ as the service to add.

RTP (Multicast)/MPEG-4
These settings are the IP address, port number, and Time-To-Live value to use for the 
media stream(s) in multicast MPEG-4 format. Only certain IP addresses and port numbers 
should be used for multicast streams. For more information, please see the online help.

Ports & devices
I/O Ports - the pinout, interface support and the control and monitoring functions 
provided by this connector are described in Unit connectors, on page 57.

RS232 - The COM port RS-232 on the Axis video server supports several operational 
modes listed on this page. For more information, please see COM ports RS-232 and 
RS-485, on page 59.

RS485 - The COM ports on the Axis video server supports several operational modes listed 
on this page. For more information, please see COM ports RS-232 and RS-485, on page 
59.
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Maintenance
• Restart - The unit is restarted without changing any of the settings. Use this method if 

the unit is not behaving as expected.
• Restore - The unit is restarted and most current settings are reset to factory default val-

ues. The settings that are not affected are:
• the boot protocol (DHCP or static)
• the static IP address
• the default router
• the subnet mask
• the system time

• Default - The default button should be used with caution. Pressing this will return all of 
the video server's settings to the factory default values (including the IP address)

• Upgrade Server - See Upgrading the firmware, on page 61.
• Backup - To take a backup of all of the parameters, and any user-defined scripts, click 

this button. If necessary, it is then possible to return to a previous configuration if set-
tings are changed and there is unexpected behavior.

• Restore - click the Browse button to locate the saved backup file (see above) and then 
click the Restore button. The settings will be restored to the previous configuration.

Notes: •Backup and Restore can only be used on the same unit running the same firmware. This feature 
is not intended for multi-configurations or for firmware upgrades.

•Loaded IV modules in the AXIS 242S IV will be reset to their default values for both Restore and 
Default. The modules themselves are retained in flash memory during these operations.
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Support
The support overview page provides valuable information on troubleshooting and contact 
information, should you require technical assistance.

The System Overview provides a summary of the status of the video server.

Logs & Reports - when contacting Axis support, please be sure to provide a valid Server 
Report with your query.

Information - The Log report and the Parameter List also provide valuable information for 
troubleshooting and when contacting Axis support service.

Configuration:

Log Level for Log Files - from the drop-down list, select the level of information to be 
added to the Log file

Log Level for Email - from the drop-down list, select the level of information to send as 
email and enter the destination email address.

Advanced
Scripting is an advanced function that provides the possibility to customize and use 
scripts. This function is a very powerful tool. 

Caution!
Improper use may cause unexpected behavior or even cause loss of contact with the 
unit. If a script does cause problems, reset the unit to its factory default settings. A 
backup file may be of use to return the unit to its latest configuration). 
 
Axis strongly recommends that you do not use this function unless you fully 
understand the consequences. Note that Axis support does not provide assistance for 
problems with customized scripts. 

For more information, please visit the Developer pages at www.axis.com/developer

Plain Config - this function is for the advanced user with experience of Axis video 
server configuration. All parameters can be set and modified from this page, 
including the audio encoding format. Help is available from the standard help pages.
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Resetting to the factory default settings
To reset the Axis video server to the original default settings, go to the System Options > 
Maintenance web page (described in Maintenance, on page 54) or use the control button 
on the Axis video server, as described below:

Using the Control Button
Follow the instructions below to reset the Axis video server to the factory default settings 
using the Control Button.

1. Switch off the Axis video 
server by disconnecting 
power.

2. Press and hold the Control 
Button while reconnecting the 
power.

3. Keep the Control button 
pressed until the Status 
Indicator displays yellow (this 
may take up to 15 seconds).

4. Release the Control Button.

5. When the Status Indicator changes to Green (may take up to 1 minute), the 
process is complete and the Axis video server has been reset.

6. Re-install the Axis video server, as described in the Installation Guide.

Control ButtonStatus Indicator
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Unit connectors
The following connectors are described in this section:

• The D-Sub connector, on page 57
• The I/O terminal connector, on page 58
• COM ports RS-232 and RS-485, on page 59
• The S-Video connector (AXIS 242S IV only), on page 59
• Y/C to BNC cable (AXIS 241S/SA only), on page 60

The D-Sub connector
The Axis video server provides one 9-pin D-Sub connector, providing the physical 
interface for an RS-232 port, used for connecting accessory equipment; such as standalone 
PTZ devices for the remote control of connected video cameras. 

Pin assignment table and pinout of the RS-232 connector:

Pin Function
1 CD 
2 - RXD
3 - TXD
4 DTR
5 GND
6 DSR
7 RTS
8 CTS
9 RI

54321

6 7 8 9
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The I/O terminal connector
This section describes the pinout and interface support provided by the 12-pin I/O terminal 
connector, which includes: 

• 4 digital transistor outputs
• 4 digital inputs
• an RS-485 interface
• auxiliary power and GND

The terminal connector is used in applications for e.g. motion detection, event triggering, 
time lapse recording, alarm notification via email, image storage to FTP locations, etc.

• Inputs - e.g. a push button. If the button is pressed, the state changes, and the 
input will be active (shown under Event Configuration > Port Status). 

• Outputs - e.g. an alarm device that can be activated from Output buttons on the 
Live View page or as an action to an Event Type. The output will show as active 
(in Event Configuration > Port Status), if the device is activated.

The Axis video server includes one (green) 12-pin connector block. Connect input/output 
devices to this block:

1. Loosen the corresponding screw on top of the pin on the connector block (see the 
table above to determine which pin to use).

2. Push the cable into the connector block and secure it by fastening the screw.

3. Once all devices are connected, connect the connector block to the video server’s 
terminal connector.

Pin Function Description
1 Auxiliary DC Power Input 7-20 VDC/min 8W. Electrically connected in parallel with the power 

connector, this provides an auxiliary connection for mains power to 
the unit. If the product is powered via this pin, use a fuse (rating: 1A 
Slow).  
This pin can also be used to power auxiliary equipment, 9vDC max 
100mA. The AXIS 242S IV can also provide power at 12V DC, 100mA.

2 GND

3 Digital Input 1 Connect to GND to activate or leave floating (or unconnected) to 
deactivate.4 Digital Input 2

5 Digital Input 3

6 Digital Input 4 

7 Transistor Output With a maximum load of 100mA and maximum voltage of 24V DC, this 
output has an open-collector NPN transistor with the emitter 
connected to pin 2 (GND). If it is to be used with an external relay, a 
diode must be connected in parallel with the load for protection 
against any voltage transients.

8 Transistor Output

9 Transistor Output

10 Transistor Output

11 RS-485 - A (non-inverting) A half-duplex RS-485 interface for controlling auxiliary equipment, 
e g. PTZ devices.12 RS-485 - B (inverting)
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Schematic diagram - I/O terminal connector
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COM ports RS-232 and RS-485
The COM Ports RS-232 and RS-485 support several operational modes:

• Generic TCP/IP - enables the video server to receive status/data and send com-
mands via TCP/IP

• Generic HTTP - enables the video server to receive status/data and send com-
mands via HTTP

• Pan Tilt Zoom (PTZ) - for controlling a PTZ device. A PTZ device requires a driver 
for its function. Drivers can be obtained from www.axis.com. Please see page 41 
for information on how to connect PTZ devices.

The S-Video connector (AXIS 242S IV only)
This connector can be used to connect Y/C video directly to the AXIS 242S IV. 

When this connector is used, it must be selected. Go to the AXIS 242S IV web pages under 
Setup > Video & Image > Video Source and select Y/C (S-video) from the Physical 
connector drop-down list.
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Y/C to BNC cable (AXIS 241S/SA only)
The AXIS 241S/SA supports conversion from Y/C (S-video) to composite video using an 
Y/C to BNC cable. The cable is available as an accessory - see the Axis Web site at: 
www.axis.com. Follow these instructions to connect the Y/C to BNC cable:

1. Connect the BNC connector marked IN to the Video In connector on the video 
server.

2. Connect the BNC connector marked OUT to the Video OUT connector on the 
video server.

3. Connect the Y/C connector to the Y/C video unit (S-video).

4. Set the dip switches on the front panel of the unit to 1=on, 2=on, 3=off, 4=off.

5. Go to the AXIS 241S/SA web pages under Setup > Video & Image > Video 
Source and select Y/C (S-video) from the Physical connector drop-down list.

One female MiniDin 4-pol connector 
split into two BNC connectors

Below is a description of how the cable can be assembled using standard components:

1. Use two male BNC connectors and one female 4-pole 
MiniDin connector.

2. Connect pin 1, 2 and shield on the MiniDin connector to 
the shield on the two BNC connectors.

3. Connect pin 3 (Y) on the MiniDin connector to centre pin 
on one of the male BNC connectors, mark this BNC 
connector with IN.

4. Connect pin 4 (C) on the MiniDin connector to centre pin 
on the other male BNC connector, mark this BNC connector 
with OUT.

The pins on the 
MiniDin connector
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Troubleshooting

Checking the firmware
Firmware is software that determines the functionality of the Axis video server. One of 
your first actions when troubleshooting a problem should be to check the currently 
installed version. The latest version may contain a correction that fixes your particular 
problem. The current firmware version in your Axis video server can be seen under Setup 
> Basic Configuration.

Upgrading the firmware
When you download firmware from the Axis Web site, your Axis product will receive the 
latest available functionality. Always read the upgrade instructions and release notes 
available with each new release, before updating the firmware.

New firmware can be downloaded to the Axis video server over the network.

Note: Pre-configured and customized settings will be retained for use when the new firmware is running (pro-
vided the features are available in the new firmware) although this is not guaranteed by Axis Communica-
tions. 

1. Save the firmware file to your computer. The latest version of the Axis video 
server firmware is available free of charge from the Axis Web site at 
www.axis.com/techsup or from your local distributor.

2. Go to Setup > System Options > Maintenance in the video server’s Web pages.

3. In the Upgrade Server section and browse to the desired firmware file on your 
computer. Click Upgrade.

Notes: •Always read the upgrade instructions available with each new release, before updating the firm-
ware.

•After starting the process, you should always wait at least 20 minutes before restarting the Axis 
video server, even if you suspect the procedure has failed.

•Your dealer reserves the right to charge for any repair attributable to faulty updating by the 
user.



 62 Axis video server - Troubleshooting
Emergency recovery procedure
If power or the network connection to the Axis video server is lost during the upgrade, the 
process will fail and the unit will become unresponsive. A flashing red Status LED 
indicates a failed upgrade. To recover the unit, follow the steps below. The serial number is 
found on the underside label on the product casing.

1. Unix/Linux - From the command line, type the following: 
arp -s <IP address of Axis video server> <Serial number> temp 
ping -s 408 <IP address of Axis video server> 
 
Windows - From a command/DOS prompt, type the following: 
arp -s <IP address of Axis video server> <Serial number> 
ping -l 408 -t <IP address of Axis video server> 

2. If the unit does not reply within a few seconds, restart it and wait for a reply. Press 
CTRL+C to stop Ping.

3. Open a web browser and type in the Axis video server’s IP address. In the page that 
appears, use the Browse button to select the upgrade file to use, e.g. axis241qa.bin or 
axis241sa.bin. Then click the Load button to restart the upgrade process. 

4. After the upgrade has completed (1-10 minutes), the unit will automatically restart and 
show a steady green on the Power and Status LEDs and flashing green or amber on the 
Network LED. 

5. Reinstall the Axis video server. 

If the emergency recovery procedure does not get the Axis video server up and running 
again, please contact Axis support at www.axis.com/techsup/ 

Support
If you contact Axis support, please help us help you resolve your problems expediently by 
providing a server report, log file and a brief description of the problem.

Server Report - go to Setup > System Options > Support Overview. The server report 
contains important information about the server and its software, as well as a list of the 
current parameters.

Log file - go to Setup > System Options > Logs & Reports. The Log file records events 
within the unit since the last restart of the system and can prove a useful diagnostic tool 
for troubleshooting.
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Symptoms, Possible Causes and Remedial Actions  
Problems setting the IP address

Using ARP/Ping - the IP address 
must be set within two minutes 
after power has been applied to 
the video server

Restart the server and try again. Ensure also the ping length is set to 408. (See the Axis video 
server Installation Guide)

The video server is located on a 
different subnet.

If the IP address intended for the Axis video server and the IP address of your computer are 
located on different subnets, you will not be able to set the IP address. Contact your network 
administrator for an IP address on the same subnet as the computer you are performing the 
installation from.

The IP address is being used by 
another device

Disconnect power from the Axis video server.  
Run the Ping command (in a Command/DOS window, type ping <IP address of unit> 

If you receive: Reply from <IP address>: bytes = 32; time = 10 ms..... - this means that the IP 
address may already be in use by another device on your network. You must obtain a new IP 
address and reinstall the unit. 

If you receive: Request timed out - this means that the IP address is available for use with your 
video server. In this case, check all cabling and reinstall the unit.

The Axis video server cannot be accessed from a web browser
Cannot log in If the Axis video server has been configured to use HTTPS, check that the protocol in the URL 

used to access the unit is correct. You may need to type this in manually (i.e. http or https) in 
the browser’s address field.

The IP address has been changed 
by DHCP

1) Move the Axis video server to an isolated network or to one with no DHCP or BOOTP server. 
Set the IP address again, using the ARP Ping command. 
2) Access the unit and disable BOOTP and DHCP in the TCP/IP settings. Return the unit to the 
main network. The unit now has a fixed IP address that will not change. 
3) As an alternative to 2), if dynamic IP address via DHCP or BOOTP is required, select the 
required service and then configure IP address change notification from the network settings. 
Return the unit to the main network. The unit will now have a dynamic IP address, but will 
notify you if the address changes.

Other networking problems Test the network cable by connecting it to another network device, then Ping that device from 
your workstation. See instructions above.

Cannot send notifications, uploads, alarms, etc, to a destination outside the local network
Firewall protection The video server can be configured to use a SOCKS server to reach networks on the other side 

of a firewall/proxy server

Your Axis video server is accessible locally, but not externally
Firewall protection Check the Internet firewall with your system administrator.

Default routers required Check if you need to configure the default router settings.

The Internet site is too heavily 
loaded

Use a script on your web server to relay images from the Axis video server to the Internet. 

The Power indicator is not constantly lit
Faulty power supply Verify that you are using the correct power adapter.

The Status indicator is flashing red and the server is inaccessible
A firmware upgrade has been 
interrupted or the firmware has 
been damaged in some other 
way.

A rescue firmware is running in the product. First, set the IP address using AXIS IP utility or ARP 
and Ping, (See the Axis video server Installation Guide). Then, using a web browser, access the 
unit and download the latest firmware to the product, see  Upgrading the firmware, on page 61.
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No images displayed in the Web interface
Problem with AMC  
(Internet Explorer only)

To enable the updating of images in Microsoft Internet Explorer, set your browser to allow 
ActiveX controls. Also, make sure that AXIS Media Control (AMC) component is installed on 
your workstation. 

Installation of additional ActiveX 
component restricted or prohib-
ited

Configure your Axis video server to use a Java applet for updating the images under 
Live View Config > Layout > Default Viewer for Internet Explorer. See the online help for more 
information.

Video Image Problems
Image too dark or too light. Check that the termination dip switch for the video source is set to the correct position. See 

also the online help on Video Source Settings

Black borders around the video 
image

Adjust the X and/or Y offset, in the Video Source Settings. See the online help for information.

Problems uploading own files There is only limited space available for the upload of your own files. Try deleting one or more 
existing files, to free up space

Missing images in uploads This can occur when trying to use a larger image buffer than is actually available. Try lowering 
the frame rate or the upload period.

Slow image update Configuring e.g. pre-buffers, motion detection, high resolution images, high frame rates, etc., 
will reduce the performance of the video server. 

Slow performance Slow performance may be caused by e.g. heavy network traffic, multiple users accessing the 
unit, low performance clients, use of features such as Motion Detection, Event handling, Image 
rotation.

Bad snapshot images
Display incorrectly configured on 
your workstation

In Display Properties, configure your display to show at least 65000 colors, i.e. at least 16-bit.

Using only 16 or 256 colors on your display will produce dithering artifacts in the image. 

Incorrect exposure in images
Incorrect line termination If the Axis video server is to be connected in loop through with other equipment, disable the 

input termination by turning the corresponding DIP switch to OFF.

Problems with the MPEG-4 format
Lower frame rate than expected. Check with the administrator that there is enough bandwidth available. Check also the settings 

for bit rate control, in the Video & Image > Advanced > MPEG-4 settings. Using an inappro-
priate video object type can also affect the frame rate. See the online help for more informa-
tion.

Check in the AMC control panel applet (MPEG-4 tab) that video processing is not set to Decode 
only I frames.

Lower the image resolution.

Reduce the number of applications running on the client computer.

No MPEG-4 displayed in the  
client.

Check that the correct network interface is selected in the AMC control panel applet (network 
tab). 

Check that the relevant MPEG-4 connection methods are enabled in the AMC control panel 
applet (network tab). 

In the AMC control applet, select the MPEG-4 tab and click the button Set to default MPEG-4 
decoder. 

No multicast MPEG-4 displayed 
in the client.

Check with your network administrator that the multicast addresses used by the  
Axis video server are valid for your network.

Check with your network administrator to see if there is a firewall preventing viewing.

Multicast MPEG-4 only accessi-
ble by local clients. 

Check if your router supports multicasting, or if the router settings between the client and the 
server need to be configured. The TTL (Time To Live) value may need to be increased.
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For additional assistance, please contact your reseller or check the product’s support pages 
on the Axis Website at www.axis.com/techsup

Poor rendering of MPEG-4 
images. 

Color depth set incorrectly on clients. Set to 16-bit or 32-bit color.

If text overlays are blurred, or if there are other rendering problems, you may need to enable 
Advanced Video Rendering. This is done on the MPEG-4 tab in the AMC control panel applet.

Ensure that your graphics card is using the latest device driver. The latest drivers can usually be 
downloaded from the manufacturer's web site. 

Color saturation is different in 
MPEG-4 and Motion JPEG.

Modify the settings for your graphics adapter. Please see the adapter's documentation for more 
information.

No audio (AXIS 241SA/AXIS 241QA only)
 Incorrect setup. Check that the sound card in the PC and the connections to the speaker and microphone are 

working. Ensure that the mute button is not pressed and the volume settings are correct. 
Ensure that full-duplex is selected if you want to have two way audio communication. 

Post Content Length in proxy 
server.

The Post Content Length set in the proxy server is too low. Set the value of the Post Content 
Length in your proxy server to 1MB or more. You may need to contact your system administra-
tor to do this.

Full duplex not supported. Sound card does not support full-duplex. For information on how to check if your sound card 
supports full-duplex, please visit http://support.microsoft.com

Firewall or router settings. Axis video server works locally, but not externally. Check the Internet firewall settings with 
your system administrator or reconfigure the default router settings.

DC power not enabled for micro-
phone.

If the microphone has a built-in amplifier then DC power must be enabled on the Audio Set-
tings page.

Audio volume too low/high
Volume settings incorrect. The volume of the microphone or speaker connected to the Axis video server is either too high 

or too low. Change the volume for the speaker or microphone in the Live View page. 

Input and output gain set incor-
rectly.

Change the input gain for the microphone and the output gain for the speaker to adjust the 
audio levels on the Audio Settings page.

Poor audio quality
Too many users. Too many users/clients listening to audio from the Axis video server may adversely affect the 

sound quality. 

User too close to microphone. Enable the speech filter in Audio > Advanced Settings.
Feedback from speaker. Enable the echo cancellation filter in Audio > Advanced Settings.
Background noise. Adjust the noise cancellation threshold and attenuation to reduce background noise levels in 

Audio > Advanced Settings.
CPU overloaded. Reduce the number of listeners and viewers and decrease the image resolution and compres-

sion.
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Technical specifications

Item Specification

Models • AXIS 241S: 1-channel video server
• AXIS 241Q: 4-channel video server
• AXIS 241SA: 1-channel video server with audio
• AXIS 241QA: 4-channel video server with audio
• AXIS 242S IV: 1-channel video server with support for Intelligent Video

Video compression • Motion-JPEG, including single snapshot JPEG images. 
• MPEG-4 Part2 (ISO/IEC 14496-2), Profiles: ASP and SP

Resolutions • 4CIF, 2CIF Expanded, 2CIF, CIF, QCIF
• Maximum 768x576 (PAL) 704x480 (NTSC)
• Minimum 176x144 (PAL) 160x120 (NTSC)

Frame rates • Motion JPEG: up to 25/30 (PAL/NTSC) fps in 4CIF (1 channel), 
up to 25/30 fps (PAL/NTSC)in CIF (4 channels)

• MPEG-4: up to 25/30 (PAL/NTSC) fps in 2CIF (1 channel), 
up to 17/20 (PAL/NTSC) fps in CIF (4 channels)

Video streaming • Simultaneous Motion JPEG and MPEG-4
• Controllable frame rate and total bandwidth
• Constant and variable bit rate (MPEG-4)

Image settings • Compression levels: 11 (Motion JPEG), 23 (MPEG-4)

• Rotation: 90o, 180o, 270o

• Aspect ratio correction
• Color and black/white
• Overlays: time, date, text, image

Audio features  
(AXIS 241QA 
AXIS 241SA)

Full-duplex audio. Select the encoding format from System Options:
ADPCM format at 24kbps, 8 kHz sampling (G.726 - select G723 from drop-down list)
ADPCM format at 32kbps, 8 kHz sampling (G.726 - select G721 from drop-down list)
PCM μ−law format at 64kbps, 8 kHz sampling (G.711 default)

Security • Multiple user levels with password protection
• IP address filtering
• HTTPS encryption

Users • 20 simultaneous viewers for Motion JPEG and/or unicast MPEG-4
• More than 20 viewers possible when using MPEG-4 multicast

Alarm and event 
management

• Events triggered by built-in multi-window motion detection, external inputs or 
according to set schedule

• Image uploads via FTP, email and HTTP
• Event notification via TCP, email, HTTP and external outputs
• Pre- and post-alarm buffer of 9 MB per channel (approx 4 min CIF video at 4 fps)

Pan/Tilt/Zoom • Drivers for all supported PTZ units available from www.axis.com
• PTZ control queuing capability



 67 Axis video server - Technical specifications
Connectors • Analog composite video, PAL/NTSC autosensing inputs
• AXIS 241Q/QA: 4 BNC video inputs
• AXIS 242S IV/AXIS 241S/SA: 1 BNC video input, 1 BNC output (loop through)
• AXIS 242S IV only - S-Video (connects Y/C video)
• Ethernet 10BaseT/100BaseTX, RJ-45
• Terminal block: 4 alarm inputs, 4 output transistors (max 24V, 0.1 A), 2-wire 

RS-485/422 (half-duplex), alternative voltage input
• D-Sub connector: RS-232
• Power: 9/12V DC (AXIS 242S IV only)
• Power: 9V DC all other models

Line/Mic In (Combined 
connector - AXIS 241QA 
and AXIS 241SA only)

• Single 3.5mm input for a mono microphone, or for line-in mono signal (uses left 
channel only from a stereo signal). 

• Mic input - High sensitivity: max -38 dBu (27 mVpp) 
• Mic input - Low sensitivity: max -32 dBu (54 mVpp) 
• Line/Mic In (mono): max 1.5 dBu (2.6 Vpp)
• DC power for an external microphone is supported through the input connector.

Line In & Mic In (separate 
connectors - AXIS 242S 
IV only)

• Line In - 3.5mm input for line-in stereo signal
• Mic In - 3.5mm input for mono microphone (uses right channel from a stereo signal)
• Mic input - High sensitivity: max 113 mVpp (with 20dB microphone amplifier gain)
• Mic input - Low sensitivity: max 1.13 Vpp (with 0 dB microphone amplifier gain)
• Line input - max. 5.6 Vpp
• DC power for an external microphone is supported through the input connector.

Line Out 
(AXIS 241QA and 
AXIS 241SA only)

• Mono audio output (line level). Can be connected to a PA system or active speaker 
with a built-in amplifier. Headphones can also be attached. 

• Line Out: max 1.5 dBu (2.6 Vpp) 
• Line Out impedance: min 32 ohm 

Processors and memory • CPU: ETRAX-100 LX 32-bit
• Video processing and compression: ARTPEC-2 chip
• RAM AXIS 241QA/241SA - 64MB
• RAM AXIS 242S IV / AXIS 241S/SA - 32MB
• Flash memory - 8 MB
• DSP (AXIS 242S IV only) - RAM 32 MB , flash memory 8 MB.

Power • External power adapter PS-K (included): 9V DC, 9W  
(AXIS 241Q/QA and AXIS 241S/SA)

• External power adapter PS-E: 12V DC/13.2W, or PS-O: 9V DC/15W  
(AXIS 242S IV only). Included.

• Via terminal connector: 7-20V DC, max 8W

Operating conditions • Temperature: +5oC to +50oC (41oF to 122oF) - AXIS 241Q/QA and AXIS 241S/SA
• Temperature: +5oC to +40oC (41oF to 113oF) - AXIS 242S IV
• Humidity: 20-80% RH (non-condensing)

System integration 
support

• API for software integration available at www.axis.com includes AXIS VAPIX HTTP 
API, AXIS Media Control SDK

• Event trigger data in video stream
• Embedded scripting
• Access to serial port peripherals via HTTP/TCP
• Embedded operating system: Linux 2.4

Item Specification
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Minimum web browsing 
requirements

• Pentium III 500 MHz or higher or equivalent AMD
• 128 MB RAM
• AGP graphics card, DirectDraw, 32 MB video RAM
• Windows XP, Windows 2000 or Windows Server 2003
• DirectX 9.0 or later
• Internet Explorer I.E 6.x or later 

For other operating systems and web browsers, see www.axis.com/techsup

Supported protocols HTTP, HTTPS, SSL/TLS*, TCP SNMPv1/v2c/v3 (MIB-II), RTSP, RTP, UDP, IGMP, RTCP, 
SMTP, FTP, DHCP, UPnP, ARP, DNS, DynDNS, SOCKS

*This product includes software developed by the Open SSL Project for use in the 
Open SSL Tool kit. See www.openssl.org

Approvals - EMC • EN55022:1998+A1 (CISPR 22:1997+A1) Class B
• EN55024:1998+A1+A2 
• EN61000-3-2:2000 
• EN61000-3-3:1995+A1
• VCCI:2003, Class B, ITE (CISPR 22:1997+A1:2000, Class B) 
• C-Tick AS/NZS 3548
• FCC part 15, Subpart B, Class B, demonstrated by compliance with EN55022:1998 

(CISPR 22:1997) Class B
• ICES-003 Class B, demonstrated by compliance with EN 55022:1998, Class B

Approvals - Safety • EN60950, UL, CSA 
• PS-K power adapter (AXIS 241Q/QA and AXIS 241S/SA)
• PS-E, PS-O power adapter (AXIS 242S IV) 

Dimensions  
(AXIS 242S IV)

• HxWxD = 42 x 140 x 230mm (1.7 x 5.5 x 9.1”) 
• Weight: 745g (1.6 lb) excluding power adapter

Dimensions (all other 
models)

• HxWxD = 42 x 140 x 155mm (1.7 x 5.5 x 6.1”) 
• Weight: 540g (1.2 lb) excluding power adapter

Intelligent video modules 
(AXIS 242S IV only)

See www.axis.com for available modules.

Complimentary Software • AXIS Media Control (AMC) - ActiveX component software required for Microsoft 
Internet Explorer, installed automatically on first use.

• Optional: AXIS IP Utility - Windows application for small installations.
• Optional: AXIS Camera Management - Windows application for large installations .

MPEG-4 licensing License for one MPEG-4 encoder and one MPEG-4 decoder included. Additional 
licenses available from Axis dealers. 

Item Specification
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General performance considerations
When setting up your system, it is important to consider how various settings and 
situations will affect performance. Some factors affect the amount of bandwidth (the bit 
rate) required, others can affect the frame rate, and some will affect both. If the load on the 
CPU reaches its maximum, this will also affect the frame rate.

The following factors are among the most important to consider:

• High image resolutions and/or lower compression levels result in larger images. 
Bandwidth affected. 

• Access by large numbers of Motion JPEG and/or unicast MPEG-4 clients. Band-
width affected.

• Simultaneous viewing of different streams (resolution, compression, etc.) by dif-
ferent clients. Frame rate and bandwidth affected.

• Accessing both Motion JPEG and MPEG-4 video streams simultaneously. Frame 
rate and bandwidth affected.

• Heavy usage of event settings affects the CPU load. Frame rate affected.
• Enabled motion detection. Frame rate and bandwidth affected.
• Heavy network utilization due to poor infrastructure. Bandwidth affected
• Viewing on poorly performing client PC lowers perceived performance. Frame 

rate affected.
• Access by large number of audio clients using full-duplex mode. Bandwidth 

affected.

Optimizing your system

To see the bandwidth and frame rate currently required by the video stream, the Axis video 
server provides a tool that can be used to display these values directly in the video image.

To do this, special format strings are added as part 
of a text overlay. Simply add #r (average frame 
rate in fps) and/or #b (average bandwidth in Kbps)  
to the overlay. 

For detailed instructions, please see the online help 
for Video & Image > Overlay Settings, and the 
help for File Naming & Date/Time Formats. 
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Important!
•The figures displayed here are the values as delivered by the server. If other restrictions are  

currently in force, (e.g. bandwidth limitation) these values might not correspond to those  
actually received by the client.

•For Motion JPEG, these values will only be accurate as long as no frame rate limit has been 
specified.

Frame rates - Motion JPEG 
The following test results show the frame rates in frames/second (fps) for Motion JPEG 
streams from the Axis video server, using a compression level of 50%. Note that these 
values are guidelines only - actual values may vary.

Frame rates - MPEG-4
The following test results show the frame rates in frames/second (fps) for MPEG-4 streams 
from the Axis video server. Note that these values are guidelines only - actual values may 
vary.

The MPEG-4 test conditions:

• Compression level = 50%
• Video Object Type = Advanced Simple
• GOV structure = IP*

*Note that setting the GOV structure to use “I-frames only” will increase the frame rate.

fps (PAL/NTSC) 
1 channel

fps (PAL/NTSC)
4 channels

4CIF 25/30 8/10
2CIF expanded 25/30 13/15

2CIF 25/30 22/27
CIF 25/30 25/30

QCIF 25/30 25/30

fps (PAL/NTSC) 
1 channel

fps (PAL/NTSC)
4 channels

4CIF 17/21 3/4
2CIF expanded 17/21 4/5

2CIF 25/30 9/10
CIF 25/30 17/20

QCIF 25/30 25/30
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Bandwidth
As there are many factors affecting bandwidth, it is very difficult to predict the required 
amounts. The settings that affect bandwidth are:

• the image resolution
• the image compression
• the frame rate
• the MPEG-4 object type
• the MPEG-4 GOV structure
• the analog cameras connected to the video servervideo server
• the audio settings

There are also factors in the monitored scene that will affect the bandwidth. These are: 

• the amount of motion
• the image’s complexity
• the lighting conditions.

For MPEG-4, if there is only limited bandwidth available, and if this is more important 
than the image quality, using a constant bit rate (CBR) is recommended. Use a variable bit 
rate (VBR) if the image quality needs to be maintained at a higher level. If supported on the 
network, consider also using MPEG-4 multicasting, as the bandwidth consumption will be 
much lower.
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Glossary 
Active Speaker - a speaker with a built-in power 
amplifier.

ActiveX - ActiveX is a standard that enables software 
components to interact with one another in a networked 
environment, regardless of the language(s) used to create 
them. Web browsers may come into contact with ActiveX 
controls, ActiveX documents, and ActiveX scripts. 
ActiveX controls are often downloaded and installed 
automatically as required. 

AF (Autofocus) - A system by which the camera lens 
automatically focuses on a selected part of the subject. 

AMC (AXIS Media Control) - AMC is the ActiveX 
component required to view moving images from an Axis 
video device in Internet Explorer. The component is 
installed automatically on the viewing computer on first 
use. Once installed, AMC can be configured from 
Windows Control Panel. 

Analog video camera - The signal from an analog video 
camera is viewed directly on e.g. a monitor in the analog 
system, which depends on traditional analog cabling. 
Alternatively, the signal can be digitized with the use of a 
video server, and can then be made available over a data 
(IP) network.

Angle - The field of view, relative to a standard lens in a 
35mm still camera, expressed in degrees, e.g. 30°. For 
practical purposes, this is the area that a lens can cover, 
where the angle of view is determined by the focal length 
of the lens. A wide-angle lens has a short focal length and 
covers a wider angle of view than standard or telephoto 
lenses, which have longer focal lengths.

API (Application Programming Interface) - An API is a 
set of routines, protocols, and tools for building software 
applications. A good API makes it easier to develop a 
program by providing all the required building blocks. 
The Axis VAPIX API allows Axis products to be 
integrated into other applications.

ARP (Address Resolution Protocol) - This protocol is used 
to associate an IP address to a hardware MAC address. A 
request is broadcast on the local network to discover the 
MAC address for an IP address.

ARTPEC (Axis Real Time Picture Encoder) - A chip 
designed by Axis for image compression. ARTPEC 
supports a range of CCD and CMOS sensors, built-in 
functionality for sharpening, backlight compensation, 
noise reduction and white balance, support for multiple 
Motion-JPEG streams,  support for MPEG-4 part 2, up to 
30 frames/second from 4 simultaneous video sources and 
real-time compression of up to 45 Megapixels/second. 

ASIC (Application Specific Integrated Circuit) - A circuit 
designed for a specific application, as opposed to a 
general purpose circuit, such as a microprocessor. 

Aspect ratio - A ratio of width to height in images. A 
common aspect ratio used for television screens and 
computer monitors is 4:3. High-definition television 
(HDTV) uses an aspect ratio of 9:16.

Autoiris (DC-Iris) - This special type of iris is electrically 
controlled by the camera, to automatically regulate the 
amount of light allowed to enter.

AVI (Audio Video Interleave) - A video format that 
supports simultaneous playback of audio and video. 

AXIS Internet Dynamic DNS Service - This free service 
provides an Axis network product with a unique DNS or 
domain name (URL address), which can then be used 
instead of an IP address to access the product from a web 
browser. 

AXIS IP Utility - A tool for discovering and setting IP 
addresses for Axis network devices. AXIS IP Utility is 
supplied free of charge by Axis.

AXIS Camera Management - A powerful and efficient 
installation and management tool for Axis network video 
products. The tool can automatically find and set IP 
addresses, show connection status and manage firmware 
upgrades of multiple devices.

Bitmap - A bitmap is a data file representing a 
rectangular grid of pixels. It defines a display space and 
color for each pixel (or "bit") in the display space. This 
type of image is known as a "raster graphic." GIF's and 
JPEG's are examples of image file types that contain 
bitmaps. Because a bitmap uses this fixed raster method, 
it cannot easily be rescaled without losing definition. 
Conversely, a vector graphic image uses geometrical 
shapes to represent the image, and can thus be quickly 
rescaled. 

Bit rate - The bit rate (in kbit/s or Mbit/s) is often referred 
to as speed, but actually defines the number of bits/time 
unit and not distance/time unit. 

Bluetooth - Bluetooth is an open standard for wireless 
transmission of voice and data between mobile devices 
(PCs, handheld computers, telephones and printers).

Bonjour - Also known as zero-configuration networking, 
Bonjour enables the automatic discovery of computers, 
devices, and services on IP networks. Bonjour allows 
devices to automatically discover each other without the 
need to enter IP addresses or configure DNS servers. 
Bonjour is developed by Apple Computer Inc.

BOOTP (Bootstrap Protocol) - A protocol that can 
automatically configure a network device (give it an IP 
address). BOOTP is the basis for a more advanced network 
management protocol, the Dynamic Host Configuration 
Protocol (DHCP).

Broadband - In network engineering terms, this describes 
transmission methods where two or more signals share 
the same carrier. In more popular terminology, broadband 
is taken to mean high-speed data transmission. 
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CCD (Charged Coupled Device) - This light-sensitive 
image device used in many digital cameras is a large 
integrated circuit that contains hundreds of thousands of 
photo-sites (pixels) that convert light energy into 
electronic signals. Its size is measured diagonally and can 
be 1/4", 1/3", 1/2" or 2/3". 

CCTV (Closed Circuit Television) - A CCTV system is a 
closed/private video system, usually constructed with 
coaxial cabling, and used within a single building/group 
of buildings. It is used to visually monitor the location for 
security or industrial purposes. Video from the CCTV 
system can be recorded and viewed on-site or remotely.

CCTV video camera - A traditional CCTV video camera is 
an analog camera, available in both monochrome (black 
and white) and color. Cameras can be set in fixed 
positions or placed on "Pan/Tilt/Zoom" devices, which 
allow the camera to be maneuvered. Using a zoom lens 
provides a closer view of the object being viewed. CCTV 
analog video cameras can be viewed over a computer 
network by using a video server. 

CGI (Common Gateway Interface) - A specification for 
communication between a web server and other (CGI) 
programs. For example, a HTML page that contains a form 
might use a CGI program to process the form data once it 
is submitted.

CIF (Common Intermediate Format) - CIF refers to the 
analog video resolutions 352x288 pixels (PAL) and 
352x240 pixels (NTSC). See also Resolution.

Client-server - Client-server describes the relationship 
between two computer programs in which one program, 
the client, makes a service request from another program, 
the server, which fulfils the request. Typically, multiple 
client programs share the services of a common server 
program. A web browser is a client program that requests 
services (the sending of web pages or files) from a web 
server.

CMOS (Complementary Metal Oxide Semiconductor) - A 
CMOS is a widely used type of semiconductor that uses 
both negative and positive circuits. Since only one of the 
circuit types is on at any given time, CMOS chips require 
less power than chips using just one type of transistor. 
CMOS image sensors also allow processing circuits to be 
included on the same chip, an advantage not possible 
with CCD sensors, which are also much more expensive to 
produce.

Coaxial cable - Coaxial cable is the standard means of 
transmitting analog video in a CCTV system. Coaxial is 
also used by cable companies to distribute television in 
residential buildings.

Codec - In communications engineering, a codec is 
usually a coder/decoder. Codecs are used in integrated 
circuits or chips that convert e.g. analog video and audio 
signals into a digital format for transmission. The codec 
also converts received digital signals back into analog 

format. A codec uses analog-to-digital conversion and 
digital-to-analog conversion in the same chip. 

Codec can also mean compression/decompression, in 
which case it is generally taken to mean an algorithm or 
computer program for reducing the size of large files and 
programs.

Composite video - A type of video signal in which the 
red, blue and green signals (sometimes audio signals too) 
are mixed together.

Compression - See Image Compression.

Contrast - Defines the degree of difference between the 
lightest and darkest parts of an image or video stream.

Control unit - If a CCTV system has more than one 
camera, there must be a way to control the video signals 
going to recorders and monitors. There are three basic 
types of Video Control Unit: Multiplexer, Switch and 
Quad.

dB (Decibels) - A unit to measure sound level changes. A 
3dB change is the smallest level change we can hear. A 
3dB change is actually twice or half the audio power 
level. A gain of 0dB will leave the signal level unchanged.

DC-Iris - This special type of iris is electrically controlled 
by the camera, to automatically regulate the amount of 
light allowed to enter.

Decoder - See video decoder. 

De-interlacing - See interlacing.

DHCP (Dynamic Host Configuration Protocol) - DHCP is 
a protocol that lets network administrators automate and 
centrally manage the assignment of Internet Protocol (IP) 
addresses to network devices in a network. 

DHCP uses the concept of a "lease" or amount of time that 
a given IP address will be valid for a computer. The lease 
time can vary, depending on how long a user is likely to 
require the network connection at a particular location. 

DHCP also supports static addresses for e.g. computers 
running web servers, which need a permanent IP address.

DNS (Domain Name System) - DNS is used to locate and 
translate Internet domain names into IP (Internet 
Protocol) addresses. A domain name is a meaningful and 
easy-to-remember name for an Internet address. For 
example the domain name www.example.com is much 
easier to remember than 192.0.34.166. The translation 
tables for domain names are contained in Domain name 
servers.

Domain server - Domains can also be used by 
organizations that wish to centralize the management of 
their (Windows) computers. Each user within a domain 
has an account that usually allows them to log in to and 
use any computer in the domain, although restrictions 
may also apply. The domain server is the server that 
authenticates the users on the network. 
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Dome network camera - A remotely controllable camera 
mounted in a special housing, characterized by the dome 
shaped glass or plastic covering behind which the camera 
resides. Usually mounted on a ceiling and looking 
downwards, a dome camera can often rotate up to 360 
degrees, thus providing excellent coverage of large areas. 

Duplex - See Full-duplex.

DVD (Digital Versatile Disc) - An optic disc with the 
same physical size as a CD, but with significantly greater 
storage capacity.

DVR (Digital Video Recorder) - A DVR records analog 
video to a hard disk in digital format. Most DVR's use the 
MPEG-2 format for encoding analog video signals.

Encoder - See Video encoder.

Ethernet - Ethernet is the most widely installed local area 
network technology. An Ethernet LAN typically uses 
special grades of twisted pair wires. The most commonly 
installed Ethernet systems are 10BASE-T and 
100BASE-T10, which provide transmission speeds up to 
10 Mbps and 100 Mbps respectively. 

ETRAX (Ethernet Token Ring AXIS) - The ETRAX chip is 
the cornerstone of Axis technology and the 'brain' in 
nearly all Axis products. A multipurpose Linux chip with 
integrated Ethernet networking and extremely flexible I/O 
options. 

Factory default settings - These are the settings that 
originally applied for a device when it was first delivered 
from the factory. If it should become necessary to reset a 
device to its factory default settings, this will, for many 
devices, completely reset any settings that were changed 
by the user. 

Firewall - A firewall works as a barrier between networks, 
e.g. between a Local Area Network and the Internet. The 
firewall ensures that only authorized users are allowed to 
access the one network from the other. A firewall can be 
software running on a computer, or it can be a standalone 
hardware device. 

Fixed dome network camera - This type of camera 
cannot be remotely controlled as regards movement, but 
is mounted in the same type of dome as a controllable 
network dome camera. This camera must be positioned 
manually to provide the required coverage.

Fixed network camera - This type of camera cannot be 
remotely controlled as regards movement. It must be  
positioned manually to provide the required coverage.

Fixed iris - See Autoiris.

Focal length - Measured in millimeters, the focal length 
of a camera lens determines the width of the horizontal 
field of view, which in turn is measured in degrees.

FTP (File Transfer Protocol) - FTP is an application 
protocol that uses the TCP/IP protocols, used to exchange 
files between computers/devices on networks. 

Frame - A frame is a complete video image. In the 2:1 
interlaced scanning format of the RS-170 and CCIR 
formats, a frame is made up of two separate fields of 
262.5 or 312.5 lines interlaced at 60 or 50 Hz to form a 
complete frame, which appears at 30 or 25 Hz. In video 
cameras with a progressive scan, each frame is scanned 
line-by-line and not interlaced; most are also displayed at 
30 and 25 Hz.

Frame rate - The frame rate used to describe the 
frequency at which a video stream is updated is measured 
in frames per second (fps). A higher frame rate is 
advantageous when there is movement in the video 
stream, as it maintains image quality throughout.

Full-duplex - Transmission of data in two directions 
simultaneously. In an audio system this would describe 
e.g. a telephone systems. Half-duplex also provides 
bi-directional communication, but only in one direction 
at a time, as in a walkie-talkie system. See also Simplex.

G.711 - The international standard for encoding 
telephone audio on a 64 kbps channel. It is a pulse code 
modulation (PCM) scheme operating at 8 kHz sample rate. 

G.726 - A frequently used speech-compression algorithm 
in telecommunications due to its high perceived speech 
quality and low resource requirements. 

Gain - Gain is the amplification factor and the extent to 
which an analog amplifier boosts the strength of a signal. 
Amplification factors are usually expressed in terms of 
power. The decibel (dB) is the most common way of 
quantifying the gain of an amplifier. 

Gateway - A gateway is a point in a network that acts as 
an entry point to another network. In a corporate network 
for example, a computer server acting as a gateway often 
also acts as a proxy server and a firewall server. A 
gateway is often associated with both a router, which 
knows where to direct a given packet of data that arrives 
at the gateway, and a switch, which furnishes the actual 
path in and out of the gateway for a given packet.

GIF (Graphics Interchange Format) - GIF is one of the 
most common file formats used for images in web pages. 
There are two versions of the format, 87a and 89a. 
Version 89a supports animations, i.e. a short sequence of 
images within a single GIF file. A GIF89a can also be 
specified for interlaced presentation.

GOV (Group Of VOPs) - A group of VOP's is the basic 
unit of an MPEG-4 video stream. The GOV contains 
different types and numbers of VOP's (I-VOP's, P-VOP's, 
etc) as determined by the GOV length and GOV structure. 
See also VOP.

GOV length - The GOV length determines the number of 
images (VOP's) in the GOV structure.  
See also GOV and VOP.

GOV structure - The GOV structure describes the 
composition of an MPEG-4 video stream, as regards the 
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type of images (I-VOP's or P-VOP's) included in the 
stream, and their internal order. See also GOV and VOP.

Half-duplex - See Full-duplex. 

HTML (Hypertext Markup Language) - HTML is the set 
of "markup" symbols or codes inserted in a file intended 
for display in web browser. The markup tells the browser 
how to display the page's words and images for the user.

HTTP (Hypertext Transfer Protocol) - HTTP is the set of 
rules for exchanging files (text, graphic images, sound, 
video, and other multimedia files) on the web. The HTTP 
protocol runs on top of the TCP/IP suite of protocols.

HTTPS (Hypertext Transfer Protocol over SSL) - HTTPS 
is a protocol used by web browsers and servers to encrypt 
and decrypt user page requests and the pages returned by 
the server. The encrypted exchange of information is 
governed by the use of an HTTPS certificate (issued by a 
Certificate Authority), which guarantees the authenticity 
of the server.

Hub - A (network) hub is used to connect multiple devices 
to the network. The hub transmits all data to all devices 
connected to it, whereas a switch will only transmit the 
data to the device it is specifically intended for.

IEEE 802.11 - A family of standards for wireless LANs. 
The 802.11a standard supports 1 or 2 Mbit/s transmission 
on the 5 GHz band. IEEE 802.11b supports data rates up 
to11 Mbit/s  on the 2.4 GHz band, while 802.11g allows 
up to 54 Mbit/s on the 2.4 GHz band.

Image compression - Image compression minimizes the 
file size (in bytes) of an image. Two of the most common 
compressed image formats are JPEG and GIF. See also 
MPEG and Motion JPEG.

Interlacing - Interlaced video is video captured at 50 
pictures (known as fields) per second, of which every 2 
consecutive fields (at half height) are then combined into 
1 frame. Interlacing was developed many years ago for 
the analog TV world and is still used widely today. It 
provides good  results when viewing motion in standard 
TV pictures, although there is always some degree of 
distortion in the image.

To view interlaced video on e.g. a computer monitor, the 
video must first be de-interlaced, to produce progressive 
video, which consists of complete images, one after the 
other, at 25 frames per second. See also Progressive scan. 

IP (Internet Protocol) - The Internet Protocol is a method 
transmitting data over a network. Data to be sent is 
divided into individual and completely independent 
"packets." Each computer (or host) on the Internet has at 
least one address that uniquely identifies it from all 
others, and each data packet contains both the sender's 
address and the receiver's address. 

The Internet Protocol ensures that the data packets all 
arrive at the intended address. As IP is a connectionless 
protocol, which means that there is no established 

connection between the communication end-points, 
packets can be sent via different routes and do not need 
to arrive at the destination in the correct order. 

Once the data packets have arrived at the correct 
destination, another protocol -  Transmission Control 
Protocol (TCP) - puts them in the right order.  
See also TCP.

IP address - An IP address is simply an address on an IP 
network used by a computer/device connected to that 
network. IP addresses allow all the connected 
computers/devices to find each other and to pass data 
back and forth. 

To avoid conflicts, each IP address on any given network 
must be unique. An IP address can be assigned as fixed, 
so that it does not change, or it can be assigned 
dynamically (and automatically) by DHCP. 

An IP address consists of four groups (or quads) of 
decimal digits separated by periods, e.g. 130.5.5.25. 
Different parts of the address represent different things. 
Some part will represent the network number or address, 
and some other part will represent the local machine 
address. See also IP (Internet Protocol).

Infrared (IR) - Infrared radiation is radiation at a longer 
wavelength than visible light, which means it cannot be 
seen by the naked human eye. As infrared radiation can 
be detected as heat, this can be shown on a screen or 
captured by a digital camera, with hotter objects showing 
up brighter against colder surroundings (e.g. a human 
body against a colder background). 

As color cameras can "see" infrared radiation as well as 
visible light, these cameras are equipped with an IR-cut 
filter, to prevent distortion of the colors the human eye 
can see. To use the camera in very dark locations or at 
night, this filter can be removed, to allow infrared 
radiation to hit the image sensor and thus produce 
images. An infrared lamp can be used for improved 
illumination for night surveillance, whilst not producing 
any extra visible light. 

Inputs/Outputs (I/O's) - The digital I/Os on, for example, 
a network camera can be used to connect any device that 
can toggle between an open and a closed circuit. 

For example, if a door switch is used as an input device, 
opening the door could trigger the upload of video images 
and the sending of notification messages. 

An output might, for example, be used to automatically 
start a siren when there is a motion detection trigger.

ISMA (Internet Streaming Media Alliance) - ISMA's goal 
is: "To accelerate the adoption and deployment of open 
standards for streaming rich media content such as video, 
audio, and associated data, over Internet protocols."

I-VOP - See VOP.
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JPEG (Joint Photographic Experts Group) - Together 
with the GIF file format, JPEG is an image file type 
commonly used on the web. A JPEG image is a bitmap, 
and usually has the file suffix '.jpg' or ".jpeg." When 
creating a JPEG image, it is possible to configure the level 
of compression to use. As the lowest compression (i.e. the 
highest quality) results in the largest file, there is a 
trade-off between image quality and file size. 

kbit/s (kilobits per second) - A measure of the bit rate, 
i.e. the rate at which bits are passing a given point. See 
also Bit rate.

LAN (Local Area Network) - A LAN is a group of 
computers and associated devices that typically share 
common resources within a limited geographical area.

Linux - Linux is an open source operating system within 
the Unix family. Because of its robustness and 
availability, Linux has won popularity in the open source 
community and among commercial application 
developers.

Lux - A standard unit of illumination measurement.

MAC address (Media Access Control address) - A MAC 
address is a unique identifier associated with a piece of 
networking equipment, or more specifically, its interface 
with the network. For example, the network card in a 
computer has its own MAC address. 

Manual iris - This is the opposite of an autoiris, i.e. the 
camera iris must be adjusted manually to regulate the 
amount of light allowed to reach the image sensor.

Mbit/s (Megabits per second) - A measure of the bit rate, 
i.e. the rate at which bits are passing a given point. 
Commonly used to give the "speed" of a network. A LAN 
might run at 10 or 100 Mbit/s. See also Bit rate.

Monitor - A monitor is very similar to a television set, but 
lacks the electronics to pick up regular television signals.

Motion JPEG - Motion JPEG is a simple 
compression/decompression technique for network video. 
Latency is low and image quality is guaranteed, regardless 
of movement or complexity of the image. Image quality is 
controlled by adjusting the compression level, which in 
turn provides control over the file size, and thereby the bit 
rate. 

High-quality individual images from the Motion JPEG 
stream are easily extracted. See also JPEG and GIF.

Megapixel - See Pixel.

MPEG (Moving Picture Experts Group) - The Moving 
Picture Experts Group develops standards for digital video 
and audio compression. It operates under the auspices of 
the International Organization for Standardization (ISO). 
The MPEG standards are an evolving series, each designed 
for a different purpose.

MPEG-2 - The designation for a group of audio and video 
coding standards, and is typically used to encode audio 
and video for broadcast signals, including digital satellite 
and Cable TV. MPEG-2, with some modifications, is also 
the coding format used by standard commercial DVD 
movies.

MPEG-4 - MPEG-4 is a group of audio and video coding 
standards and related technology. The primary uses for 
the MPEG-4 standard are web (streaming media) and CD 
distribution, conversational (videophone), and broadcast 
television.

Most of the features included in MPEG-4 are left to 
individual developers to decide whether to implement 
them or not. This means that there are probably no 
complete implementations of the entire MPEG-4 set of 
standards. To deal with this, the standard includes the 
concept of "profiles" and "levels", allowing a specific set 
of capabilities to be defined in a manner appropriate for a 
subset of applications.

Multicast - Bandwidth-conserving technology that 
reduces bandwidth usage by simultaneously delivering a 
single stream of information to multiple network 
recipients. See also Unicast.

Multiplexer - A multiplexer is a high-speed switch that 
provides full-screen images from up to 16 analog 
cameras. Multiplexers can playback everything that 
happened on any one camera with no interference from 
the other cameras on the system.

Network camera (Network video camera) - A network 
camera is a camera and computer combined in one 
intelligent unit. It captures and sends live video directly 
over an IP network such as a LAN, intranet or the 
Internet. Users can view and/or manage the camera using 
a standard web browser or application software from any 
local or remote computer on a network. The camera 
allows multiple authorized viewers from different 
locations to simultaneously access images. A network 
camera is sometimes known as an IP camera.

Network connectivity - The physical (wired or wireless) 
and logical (protocol) connection of a computer network 
or an individual device to a network, such as the Internet 
or a LAN.

Network video - Network video (often referred to as 
IP-Surveillance for specific applications within security 
surveillance and remote monitoring) is a system that gives 
users the ability to monitor and record video over an IP 
network (LAN/WAN/Internet).

NTSC (National Television System Committee) - NTSC is 
an analog color encoding system used in television 
systems in Japan, the United States and other parts of the 
Americas. NTSC defines the video signal using 525 TV 
lines per frame, at  a refresh rate equal to 30 frames per 
second. See also PAL.
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NVR (Network Video Recorder) - A dedicated Network 
Video Recorder (NVR) can be used to gather data streams 
from remote network cameras and video servers and store 
them on a hard disk. An NVR can be a standard 
networked PC, or a dedicated video recording hard disk 
server with its own software application.

OEM (Original Equipment Manufacturer) - This is a 
designation for companies that manufacture equipment 
that is then marketed and sold to other companies under 
their own names.

PAL (Phase Alternating Line) - PAL is an analog color 
encoding system used in television systems in Europe and 
in many other parts of the world. PAL defines the video 
signal using 625 TV lines per frame, at  a refresh rate 
equal to 25 frames per second. See also NTSC.

PDA (Personal Digital Assistant) - A small handheld 
computer, which usually provides at least a calendar, an 
organizer and a notepad.

PEM (Privacy Enhanced Mail) - An early standard for 
securing electronic mail. The PEM-format is often used 
for representing an HTTPS certificate or certificate 
request.

Ping - Ping is a basic network program used 
diagnostically to check the status of a network host or 
device. Ping can be used to see if a particular network 
address (IP address or host name) is occupied or not, or if 
the host at that address is responding normally. Ping can 
be run from e.g. the Windows Command prompt or the 
command line in Unix.

Pixel (Picture Element) - A pixel is one of the many tiny 
dots that make up a digital image. The color and intensity 
of each pixel represents a tiny area of the complete image. 

PoE (Power over Ethernet) - Power over Ethernet 
provides power to a network device via the same cable as 
used for the network connection. This is very useful for 
IP-Surveillance and remote monitoring applications in 
places where it may be too impractical or expensive to 
power the device from a power outlet. 

PPP (Point-to-Point Protocol) - A protocol that uses a 
serial interface for communication between two network 
devices. For example, a PC connected by a phone line to a 
server. 

PPTP (Point-to-Point Tunneling Protocol) - A protocol 
(set of communication rules) that allows corporations to 
extend their own corporate network through private 
"tunnels" over the public Internet. In this way a 
corporation can effectively use a WAN (Wide Area 
Network) as a large single LAN (Local Area Network). This 
kind of interconnection is known as a virtual private 
network (VPN). 

Pre/post alarm images - The images from immediately 
before and after an alarm. These images are stored in a 
buffer for later retrieval.

Progressive scan - Progressive scan, as opposed to 
interlaced video, scans the entire picture, line by line 
every sixteenth of a second. In other words, captured 
images are not split into separate fields as in interlaced 
scanning. 

Computer monitors do not need interlace to show the 
picture on the screen, but instead show them 
progressively, on one line at a time in perfect order i.e. 1, 
2, 3, 4, 5, 6, 7 etc., so there is virtually no "flickering" 
effect. In a surveillance application, this can be critical 
when viewing detail within a moving image, such as a 
person running. A high-quality monitor is required to get 
the best from progressive scan. See also Interlacing.

Protocol - A special set of rules governing how two 
entities will communicate. Protocols are found at many 
levels of communication, and there are hardware 
protocols and software protocols. 

Proxy server - In an enterprise that uses the Internet, a 
proxy server acts as an intermediary between a 
workstation user and the Internet. This provides security, 
administrative control, and a caching service. Any proxy 
server associated with a gateway server, or part of a 
gateway server, effectively separates the enterprise 
network from the outside network and the local firewall. 
It is the firewall server that protects the enterprise 
network from outside intrusion. 

PTZ (Pan Tilt Zoom) - A PTZ-enabled camera can be 
remotely controlled so as to change the view from the 
camera. Panning is the movement of the camera along its 
horizontal axis, tilting is the movement of the camera 
along its vertical axis, and zooming is the adjustment of 
the zoom lens to magnify the view.

P-VOP - See VOP.

Quad view - A Quad view displays images from up to 
four cameras on a single screen; where the images from 
each camera take up approximately a quarter of the 
display area. 

Remote monitoring - Network video gives users the 
ability to gather information at all key points of an 
operation and view it in realtime. This makes the 
technology ideal for monitoring equipment, people and 
places, both locally and remotely. Application examples 
include traffic and production line monitoring, and the 
monitoring of multiple store locations. 

Resolution - Image resolution is a measure of how much 
detail a digital image can hold: the greater the resolution, 
the greater the level of detail. Resolution can be specified 
as the number of pixel-columns (width) by the number of 
pixel-rows (height), e.g. 320x240. 

Alternatively, the total number of pixels (usually in 
megapixels) in the image can be used. In analog systems 
it is also common to use other format designations, such 
as CIF, QCIF, 4CIF, etc.
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RS-232 - A long-established standard that describes the 
physical interface and protocol for low-speed serial data 
communication between devices. This is the interface that 
e.g. a computer uses to talk to and exchange data with a 
modem and other serial devices. 

RS-422 - A serial data communication protocol that 
specifies 4-wire, full-duplex, differential line, multi-drop 
communications. It provides balanced data transmission 
with unidirectional/non-reversible, terminated or 
non-terminated transmission lines. RS-422 does not allow 
multiple drivers, only multiple receivers. Maximum 
recommended range is 4,000 feet (1200 meters). 
Maximum recommended baud rate is 10Mbit/s.

RS-485 - An upgraded version of RS-422 that supports 
up to 32 devices on the same connection. RS-485 is an 
electrical specification of a two-wire, half-duplex, 
multipoint serial connection. It enables the configuration 
of inexpensive local networks and multidrop 
communications links. It offers high data transmission 
speeds (up to 10Mbit/s), and as it uses a differential 
balanced line over twisted pair (like RS-422), it can span 
relatively large distances (4000 feet or 1200 meters). 
RS-485 only specifies the electrical characteristics of the 
driver and the receiver. It does not specify or recommend 
any data protocol.

RTCP (Real-Time Control Protocol) - RTCP provides 
support for real-time conferencing of groups of any size 
within an intranet. This support includes source 
identification and support for gateways like audio and 
video bridges as well as multicast-to-unicast translators. 
It offers quality-of-service feedback from receivers to the 
multicast group as well as support for the synchronization 
of different media streams. 

RTP (Real-Time Transport Protocol) - An Internet 
protocol for the transport of real-time data, e.g. audio and 
video. It can be used for media-on-demand as well as 
interactive services such as Internet telephony. 

RTSP (Real Time Streaming Protocol) - A control 
protocol, and a starting point for negotiating transports 
such as RTP, multicast and Unicast, and for negotiating 
codecs. RTSP can be considered a "remote control" for 
controlling the media stream delivered by a media server. 
RTSP servers typically use RTP as the protocol for the 
actual transport of audio/video data.

Router - A device that determines the next network point 
to which a packet should be forwarded on its way to its 
final destination. A router creates and/or maintains a 
special routing table that stores information on how best 
to reach certain destinations. A router is sometimes 
included as part of a network switch. See also Switch.

Security surveillance - Network video's advanced 
functionality makes it highly suited to the applications 
involved in security surveillance. The flexibility of digital 
technology enhances security personnel's ability to 

protect people, property and assets. Such systems are 
therefore an especially attractive option for companies 
currently using CCTV.

Server - In general, a server is a computer program tha 
provides services to other computer programs in the same 
or other computers. A computer running a server program 
is also frequently referred to as a server. In practice, the 
server may contain any number of server and client 
programs. A web server is the computer program that 
supplies the requested HTML pages or files to the client 
(web browser). 

Sharpness - This is the control of fine detail within a 
picture. This feature was originally introduced into color 
TV sets that used notch filter decoders. This filter took 
away all high frequency detail in the black and white 
region of the picture. The sharpness control attempted to 
put some of that detail back in the picture. Sharpness 
controls are mostly superfluous in today's high-end TVs. 
The only logical requirement for it nowadays is on a VHS 
machine. 

Simplex - In simplex operation, a network cable or 
communications channel can only send information in 
one direction. See also Full-duplex.

SMTP (Simple Mail Transfer Protocol) - Used for sending 
and receiving e-mail. However, as it is "simple," it is 
limited in its ability to queue messages at the receiving 
end, and is usually used with one of two other protocols, 
POP3 or IMAP. These other protocols allow the user to 
save messages in a server mailbox and download them 
periodically from the server. 

SMTP authentication - An extension of SMTP, where the 
client is required to log into the mail server before or 
during the sending of email. It can be used to allow 
legitimate users to send email while denying the service to 
unauthorized users, such as spammers. 

SNMP (Simple Network Management Protocol) - SNMP 
forms part of the Internet Protocol suite, as defined by the 
Internet Engineering Task Force. The protocol can support 
monitoring of network-attached devices for any 
conditions that warrant administrative attention.

Sockets - Sockets are a method for communication 
between a client program and a server program over a 
network. A socket is defined as "the endpoint in a 
connection." Sockets are created and used with a set of 
programming requests or "function calls" sometimes 
called the sockets application programming interface 
(API). 

SSL/TSL  
(Secure Socket Layer/Transport Layer Security) - These 
two protocols (SSL is succeeded by TSL) are cryptographic 
protocols that provide secure communication on a 
network. SSL is commonly used over HTTP to form 
HTTPS, as used e.g. on the Internet for electronic financial 
transactions. SSL uses public key certificates to verify the 
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identity of the server. 

Subnet & subnet mask - A subnet is an identifiably 
separate part of an organization's network. Typically, a 
subnet may represent all the machines at one geographic 
location, in one building, or on the same local area 
network (LAN). Having an organization's network divided 
into subnets allows it to be connected to the Internet with 
a single shared network address.

The subnet mask is the part of the IP address that tells a 
network router how to find the subnet that the data 
packet should be delivered to. Using a subnet mask saves 
the router having to handle the entire 32-bit IP address; it 
simply looks at the bits selected by the mask.

Switch - A network device that connects network 
segments together, and which selects a path for sending a 
unit of data to its next destination. In general, a switch is 
a simpler and faster mechanism than a router, which 
requires knowledge about the network and how to 
determine the route. Some switches include the router 
function. See also Router.

TCP (Transmission Control Protocol) - TCP  is used along 
with the Internet Protocol (IP) to transmit data as packets 
between computers over the network. While IP takes care 
of the actual packet delivery, TCP keeps track of the 
individual packets that the communication (e.g. requested 
a web page file) is divided into, and, when all packets 
have arrived at their destination, it reassembles them to 
re-form the complete file.

TCP is a connection-oriented protocol, which means that 
a connection is established between the two end-points 
and is maintained until the data has been successfully 
exchanged between the communicating applications. 

Telnet - Telnet is a simple method with which to access 
another network device, e.g. a computer. The HTTP 
protocol and the FTP protocols allow you to request 
specific files from remote computers, but do not allow you 
logon as a user of that computer. With Telnet, you log on 
as a regular user with whatever privileges you may have 
been granted for specific applications and data residing 
on that computer.

Time-lapse recorder - This type of video recorder is 
commonly used in the security industry and has the 
ability to record up to one week of video on a single tape. 
The most commonly used timing is the 24-hour mode. 
Having to change tapes only once a day and retaining 
large amounts of information are perceived as key 
advantages in using this particular mode of recording.

TVL (TV Lines) - A method of defining resolutions in 
analog video.

UDP (User Datagram Protocol) - UDP is a 
communications protocol that offers limited service for 
exchanging data in a network that uses the Internet 
Protocol (IP). UDP is an alternative to the Transmission 

Control Protocol (TCP). The advantage of UDP is that it is 
not required to deliver all data and may drop network 
packets when there is e.g. network congestion. This is 
suitable for live video, as there is no point in 
re-transmitting old information that will not be displayed 
anyway.

Unicast - Communication between a single sender and a 
single receiver over a network. A new connection is 
established for each new user. See also Multicast.

UPnPTM - A set of computer network protocols that allows 
the automatic peer-to-peer detection of devices on the 
network. UPnP is promoted by the UPnP Forum.

URL (Uniform Resource Locator) - An "address" on the 
network.

USB (Universal Serial Bus) - A plug-and-play interface 
between a computer and peripheral devices (scanners, 
printers etc)

Varifocal lens - A lens that provides a wide range of focal 
lengths, as opposed to a lens with a fixed focal length, 
which only provides one. 

Video camera - See Network camera and CCTV video 
camera.

Video decoder - A network video decoder converts digital 
video and audio streams back into analog signals, which 
can then be displayed on standard TV sets, analog 
monitors and video switches. 

Video encoder (video server) - A video encoder/server 
digitizes analog video signals and sends digital images 
directly over an IP network, such as a LAN, intranet or the 
Internet. In effect, it turns an analog video system into a 
network video system and enables users to view live 
images using a web browser or application software on 
any local or remote computer on a network. 

Video management software - Video management 
software supplies the means for monitoring, analyzing 
and recording network video. In its simplest form, it offers 
live viewing, storage and retrieval of video sequences. 
Advanced applications may also provide support for 
recording of live video from multiple devices, different 
recording modes, search functions, remote access via a 
web browser, control of PTZ devices, etc. 

VMD (Video Motion Detection) - Video Motion detection 
defines activity (motion) in a monitored scene by 
analyzing image data and differences in series of images. 
This detection can, for example, be used to trigger an 
alarm event in a network camera and start the upload of 
images from the camera.

Video switcher - An analog video switcher sequentially 
displays full screen images, from one camera after 
another, typically at 3-5 seconds intervals. Other camera 
sources are not recorded while the image source from one 
camera is displayed on screen.
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VPN (Virtual Private Network) - This creates a secure 
"tunnel" between the points within the VPN. Only devices 
with the correct "key" will be able to work within the 
VPN. The VPN network can be within a company LAN 
(Local Area Network), but different sites can also be 
connected over the Internet in a secure way. One common 
use for VPN is for connecting a remote computer to the 
corporate network, via e.g. a direct phone line or via the 
Internet.

VOP (Video Object Plane) - A VOP is an image frame in 
an MPEG-4 video stream. There are several types of VOP:

- An I-VOP is a complete image frame.

- An P-VOP codes the differences between images, as long 
as it is more efficient to do so. Otherwise it codes the 
whole image, which may also be a completely new image. 

WAN (Wide-Area-Network) - Similar to a LAN, but on a 
larger geographical scale. 

W-LAN (Wireless LAN) - A wireless LAN is a wireless 
local area network that uses radio waves as its carrier: 
where the network connections for end-users are wireless. 
The main network structure usually uses cables.

Web camera (Webcam) - A camera that requires a 
constant connection (via e.g. USB) to a PC for its 
operation. See also Network camera. 

Web server - A program that allows web browsers to 
retrieve files from computers connected to the Internet. 
The Web server listens for requests from browsers and 
upon receiving a request for a file sends it back to the 
browser. The primary function of a Web server is to serve 
pages to other remote computers.

WEP (Wireless Equivalent Privacy) - A wireless security 
protocol, specified in the IEEE 802.11 standard, which is 
designed to provide a wireless local area network (WLAN) 
with a level of security and privacy comparable to that 
usually expected of a wired LAN. Security is at two 
different levels; 40-bit and 128-bit encryption. The higher 
the bit number, the more secure the encryption.

WINS (Windows Internet Naming Service) - Part of the 
Microsoft Windows NT Server, WINS manages the 
association of workstation names and locations with IP 
addresses, without the user or administrator having to be 
involved in each configuration change. 

WPA-PSK (Wi-Fi Protected Access - Pre-Shared Key) - 
This wireless encryption method uses a pre-shared key 
(PSK) for key management. Keys can usually be entered as 
manual hex values, as hexadecimal characters, or as a 
Passphrase. WPA-PSK provides a greater degree of 
security than WEP.

Zoom lens - A zoom lens can be moved (zoomed) to 
enlarge the view of an object to show more detail.  
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